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 Learning Objectives 
After completing this chapter, you will be able to:
• Create different types of mesh
• Apply various types of Restrains
• Apply various types of Load 
• Create various types of Connections
• Perform Static analysis
• Perform Frequency analysis
• Perform Thermal analysis
• Compute the analysis result
• Generate the analysis report
• Animate the analysis result
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Introduction To FEA
The Finite Element Analysis (FEA) is a computing technique that is used to obtain approximate 
solution to boundary value problems. It is a numerical procedure to find the solution of 
engineering problems like structural analysis, thermal analysis, fluid flow analysis, electrical 
analysis and so on. These problems are basically the mathematical models for physical situation. 
These mathematical models are differential equations with a set of boundary values and initial 
conditions. The method used to derive these equations is called Finite Element Method (FEM). 

The concept of FEA can be explained with a small example of measuring the perimeter of a 
circle. To measure the perimeter of a circle without using the conventional formula, divide the 
circle into equal segments, as shown in Figure 19-1. Next, join the start point and the endpoint 
of each of these segments with a straight line. Now, you can measure the length of straight line 
very easily, and thus, the perimeter of the circle by adding the length of these straight lines.

Figure 19-1 The circle divided into small equal segments

If the number of segments into which a circle divided is less, you will not get accurate results. 
For accuracy, divide the circle into more number of segments. However, with more segments, 
the time required to get the accuracy will be more. The same concept can be applied to FEA 
also. Therefore, there is always a compromise between accuracy and solving time while using this 
method. This compromise between accuracy and solving time makes it an approximate method.

The FEA was first developed to be used in the aerospace and nuclear industries, where the safety 
of structures is critical. Today, even the simplest of products rely on FEA for design evaluation.

The FEA simulates the loading conditions of a design and determines the design response in 
those conditions. It can be used in new product design as well as in existing product refinement. 
A model is divided into a finite number of regions/divisions called elements. These elements 
can be of predefined shapes, such as triangular, quadrilateral, hexahedron, tetrahedron, and 
so on. The predefined shape of an element helps define the equations that describe how the 
element will respond to certain loads. The sum of the responses of all elements in a model gives 
the total response of the design.
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TYPES OF ENGINEERING ANALYSIS
The following types of analysis can be performed by using the FEA software:

1.	 Structural analysis
2.	 Thermal analysis
3.	 Fluid flow analysis
4.	 Electromagnetic field analysis
5.	 Coupled field analysis

Structural Analysis
In structural analysis, first the nodal degrees of freedom (displacement) are calculated and 
then the stress, strains, and reaction forces are calculated from nodal displacements. The 
classification of structural analysis is shown in Figure 19-2. The types of structural analysis are 
discussed next.

Figure 19-2  Types of structural analysis

Static Analysis
In static analysis, the load or field conditions do not vary with respect to time. Therefore, it 
is assumed that these conditions are applied gradually, not suddenly. The system under this 
analysis can be linear or nonlinear. The inertia and damping effects are ignored in structural 
analysis. In structural analysis, the following matrices are solved:

				    [K] x [X ]= [F]
			   Where, 
					     K = Stiffness Matrix
					     X = Displacement Matrix
					     F = Load Matrix

The above equation is called the force balance equation for the linear system. If the elements 
of matrix [K] are the function of [X], the system is known as the nonlinear system. Nonlinear 
systems include large deformation, plasticity, creep, and so on. The loadings that can be applied 
in a static analysis include: 

1.	 Externally applied forces and pressures 
2.	 Steady-state inertial forces (such as gravity or rotational velocity) 
3.	 Imposed (non-zero) displacements 
4.	 Temperatures (for thermal strain) 
5.	 Fluences (for nuclear swelling)
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Following can be the outputs of analysis performed by FEA software:

1.	 Displacements
2.	 Strains
3.	 Stresses
4.	 Reaction forces

Dynamic Analysis
In dynamic analysis, the load or field conditions do vary with time. Therefore, it is assumed that 
these conditions are applied suddenly. The system can be linear or nonlinear. The dynamic load 
includes oscillating loads, impacts, collisions, and random loads. The three main categories of 
the dynamic analysis are discussed next.

Modal Analysis
It is used to calculate the natural frequency and mode shape of a structure.

Harmonic Analysis
It is used to calculate the response of a structure to the loads that are varying with time 
harmonically.

Transient Dynamic Analysis
It is used to calculate the response of a structure to arbitrary time varying loads.

Spectrum Analysis
This is an extension of the modal analysis and is used to calculate stress and strain due to the 
response of the spectrum (random vibrations). For example, you can use it to analyze how well 
a structure will perform and survive in an earthquake.

Buckling Analysis
This type of analysis is used to calculate the buckling load and the buckling mode shape. Slender 
structures (thin and long) when loaded in the axial direction, buckle under relatively small loads. 
For such structures, the buckling load becomes a critical design factor.

Explicit Dynamic Analysis
This type of structural analysis is used to get fast solutions for large deformation dynamics and 
complex contact problems, for example, explosions, aircraft crash worthiness, and so on.

Thermal Analysis
The thermal analysis is used to determine the temperature distribution and related thermal 
properties such as Thermal distribution, Amount of heat loss or gain, Thermal gradients and 
Thermal fluxes.

The types of Thermal analysis are: 
1. Steady state thermal analysis
2. Transient thermal analysis
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Steady State Thermal Analysis
In this analysis, the system is studied under steady thermal loads with respect to time.

Transient Thermal Analysis
In this analysis, the system is studied under varying thermal loads with respect to time.
  

Fluid Flow Analysis
This analysis is used to determine the flow distribution and temperature of a fluid. The outputs 
that are expected from the fluid flow analysis are velocities, pressure, temperature, and film 
coefficients.

Electromagnetic Field Analysis
This type of analysis is conducted to determine the magnetic fields in electromagnetic devices. 
The types of electromagnetic analyses are:

1.	 Static analysis
2.	 Harmonic analysis
3.	 Transient analysis

Coupled Field Analysis
This type of analysis considers the mutual interaction between multiple fields. It is impossible 
to solve fields separately because they are interdependent. Therefore, you need a program that 
can solve both the physical problems by combining them.

For example, if a component is bent in different shapes using one of the metal forming processes 
and then subjected to heating, the thermal characteristics of the component will depend on the 
new shape of the component. Therefore, first the shape of the component has to be determined 
through structural simulations. This is known as coupled field analysis.

GENERAL PROCEDURE TO CONDUCT FINITE ELEMENT 
ANALYSIS 
The following steps are used to conduct the Finite Element Analysis:

1.	 Create model.
2.	 Define the element type.
3.	 Divide the given problem into nodes and elements (mesh the model).
4.	 Set the type of analysis to be used.
5.	 Apply material properties and boundary conditions.
6.	 Derive element matrices and equations.
7.	 Assemble element equations.
8.	 Solve the unknown quantities at nodes.
9.	 Interpret the results.
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FEA through Software
The Finite Element Analysis process can be carried out in three main phases using software: 
preprocessor, solution, and postprocessor, refer to Figure 19-3.

Figure 19-3   The general process of FEA

Preprocessor
The preprocessor is a phase that processes the input data to produce the results, which are used 
as input in the subsequent phase (solution). The following are the input data that need to be 
given to the preprocessor:

1.	 Type of analysis
2.    Geometric Model
3.	 Meshing
4.	 Material properties 
5.	 Loadings and boundary conditions

The input data are preprocessed for the output data. These data files are used in the subsequent 
phase (solution), refer to Figure 19-3.

Solution
The solution phase is completely automatic. The FEA software generates element matrices, 
computes nodal values and derivatives, and stores the result data in files. These files are further 
used in the subsequent phase (postprocessor) to review and analyze the results through the 
graphic display and tabular listings, refer to Figure 19-3.

Postprocessor
The output from the solution phase (result data files) is in numerical form and consists of nodal 
values of the field variable and its derivatives. For example, in structural analysis, the output of 
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the postprocessor is nodal displacement and stress in elements. The postprocessor processes the 
result data and displays them in graphical form to check or analyze the result. The graphical 
output gives the detailed information about the required result data. The postprocessor phase 
is automatic and generates graphical output in the specified form, refer to Figure 19-3.

IMPORTANT TERMS AND DEFINITIONS
There are some important terms and definitions used in FEA software that are discussed next.

Strength
When a material is subjected to an external load, the system undergoes a deformation. The 
material in turn offers resistance against this deformation. This resistance is offered by the 
material by virtue of its strength.

Load
The external force acting on a body is called load.

Stress
The force of resistance offered by a body per unit area against the deformation is called stress. 
The stress is induced in the body while the load is being applied on the body. The stress is cal-
culated as load per unit area.
			   p = F/A

                  			   Where,
                  				    p = Stress in N/mm2 

                  				    F = Applied Force in Newton
                  				    A = Cross-Sectional Area in mm2

The material can undergo various types of stresses which are discussed next.

Tensile Stress
If the resistance offered by a body is against the increase in the size, the body is said to be under 
tensile stress. 

Compressive Stress
If the resistance offered by a body is against the decrease in the size, the body is said to be under 
compressive stress. Compressive stress is just the reverse of tensile stress.

Shear Stress
The shear stress exists when two bodies tend to slide across each other in any typical plane of 
shear on the application of force parallel to that plane. In other words, shear stress is generated 
in the body when force is applied parallel to the cross-section of the body. 

	 	 Shear Stress = Shear resistance (R) / Shear area (A)
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Strain
When a body is subjected to a load (force), its length changes. The ratio of change in the length 
to the original length of the member is called strain. If the body returns to its original shape 
on removing the load, the strain is called elastic strain. If the body remains distorted after 
removing the load, the strain is called plastic strain. The strain can be of three types, tensile, 
compressive, and shear strain.

	 	 Strain (e) = Change in Length (dl) / Original Length (l)

Elastic Limit
The maximum stress that can be applied to a material without producing the permanent 
deformation is known as the elastic limit of the material. If the stress is within the elastic limit, 
the material returns to its original shape and dimension on removing the external force. The 
following laws are used to define the response of elastic limit.

Hooke’s Law
This law states that the stress is directly proportional to the strain within the elastic limit.
		
		  Stress / Strain = Constant  (within the elastic limit)

Young’s Modulus or Modulus of Elasticity
In case of axial loading, the ratio of intensity of the tensile or compressive stress to the 
corresponding strain is constant. This ratio is called Young’s modulus, and is denoted by E.
				  
		  E = p/e

Shear Modulus or Modulus of Rigidity
In case of shear loading, the ratio of shear stress to the corresponding shear strain is constant. 
This ratio is called Shear modulus, and it is denoted by C, N, or G.

Ultimate Strength
The maximum stress that a material withstands when subjected to an applied load is called its 
ultimate strength.

Yield Strength
The maximum stress that can be developed in a material without causing plastic deformation 
is called its yield strength.

Factor of Safety
The ratio of the ultimate strength to the estimated maximum stress in ordinary use (design stress) 
is known as factor of safety. It is necessary that the design stress is within the elastic limit and to 
achieve this condition, the ultimate stress should be divided by a ‘factor of safety’.

Lateral Strain
If a cylindrical rod is subjected to an axial tensile load, the length (l) of the rod will increase 
(dl) and the diameter (0) of the rod will decrease (d0). In short, the longitudinal stress will not 
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only produce a strain in its own direction, but will also produce a lateral strain. The ratio dl/l is 
called the longitudinal strain or the linear strain, and the ratio d 0 / 0  is called the lateral strain.

Poisson’s Ratio
The ratio of the lateral strain to the longitudinal strain is constant within the elastic limit. This ratio 
is called the Poisson’s ratio and is denoted by μ. The value of  ‘μ’ lies between 0.0 to 0.5.	
		
		  Poisson’s ratio (μ) = Lateral Strain / Longitudinal Strain

Bulk Modulus
If a body is subjected to equal stresses along the three mutually perpendicular directions, the 
ratio of the direct stresses to the corresponding volumetric strain is found to be constant for 
a given material, when the deformation is within a certain limit. This ratio is called the bulk 
Modulus and is denoted by K.

Stress Concentration
The value of stress changes abruptly in the regions where the cross-section or profile of a structural 
member changes abruptly. The phenomenon of this abrupt change in stress is known as stress 
concentration and the region of the structural member affected by stress concentration is known 
as the region of stress concentration. The region of stress concentration needs to be meshed 
densely to get accurate results.
 

Bending
When a force is applied perpendicular to the longitudinal axis of a body, the body starts 
deforming. This phenomenon is known as bending. In case of bending, strains vary linearly 
from the centerline of a beam to the circumference. In case of pure bending, the value of strain 
is zero at the center line. 

Bending Stress
When a non-axial force is applied on a structural member, some compressive and tensile stresses 
are developed in the member. These stresses are known as bending stresses.

Creep
At elevated temperature and constant load, many materials continue to deform, but at a slow 
rate. This behavior of materials is called creep. At a constant stress and temperature, the rate of 
creep is approximately constant for a long period of time. After a certain amount of deformation, 
the rate of creep increases, thereby causing fracture in the material. The rate of creep is highly 
dependent on both the stress and the temperature.

Degrees of Freedom (DOF)
The Degrees of freedom is defined as the freedom allowed to a given object to move and rotate 
in any direction in space.

There are six DOFs for any object in 3-dimensional (3D) space: 3 translational DOFs (one each in 
the X,Y and Z directions) and 3 rotational DOFs (one rotation about each of the X, Y, and Z axes).
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Meshing
The Finite Element Method (FEM) is a numerical approximation method which investigates the 
behavior of complex structures by breaking it down into smaller and simpler pieces. These pieces 
are called finite elements which are connected to each other through nodes. These elements 
and nodes are also called meshes and the process of generating mesh is known a meshing. The 
types of mesh elements are discussed next.

Type of Mesh Elements
In meshing, instead of specifying an element shape, you need to specify the type of meshing to 
be used for a particular type of element. Different types of meshes are used for different types 
of parts. These meshes type can be described as follow:

One Dimensional Elements
One dimensional mesh element type is used when one dimension of a part is very large as com-
pared to the third dimension. The shape of the 1D element is a line. Example of one dimensional 
elements are rod, truss (bar), and beam elements.

Two Dimensional Elements
Two dimensional mesh element type is used when two dimensions of a part are larger compared 
to the other dimension. The shape of the 2D element are triangle and the quadrilateral. Two 
dimensional elements are planer elements and are also known as surface elements. 

Three Dimensional Elements
Three dimensional mesh element type is used when all the three dimensions of a part are 
comparable to each other. The various shape of the 3D element are tetrahedron, quadrilateral 
pyramid, triangular prism, and hexahedron. They all have triangular and quadrilateral faces. 
Three dimensional elements are also known as solid elements.

The Figure 19-4 shows various types of mesh elements with number of nodes. 

Figure 19-4  Different type of mesh elements
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Advanced Meshing Tools workbench
The Advanced Meshing Tools workbench provides you tools to quickly generate a finite element 
model for the complex parts with advanced control on mesh specifications whether they are 
surface parts or solid parts.

Staring the Advanced Meshing Tools Workbench
Start a new session of CATIA V5. Choose Start > Analysis and Simulation > Advanced Mesh-
ing Tools from the menu bar to start a new file in the Advanced Meshing Tools workbench. 
You can also invoke the Advanced Meshing Tools workbench by choosing File> New from the 
menubar. On doing so, the New dialog box is displayed. In this dialog box, select the Analysis 
option and choose OK. To import a part into this workbench, make sure that part file is already 
opened in the background before invoking this workbench.

Note
The workbench that will be invoked on selecting the Analysis option from the New dialog box 
depends on the last workbench that was invoked from the Start > Analysis & Simulation. Else, 
the Advanced Meshing Tools workbench will be invoked by default.

On invoking the Advanced Meshing Tools workbench, a new environment gets started. The 
screen display of the CATIA V5 after invoking the Advanced Meshing Tools workbench is shown 
in Figure 19-5. You will notice that the toolbars related to this workbench will also be displayed. 
The tools in these toolbars are discussed later in this chapter.

Figure 19-5  Screen displayed after starting a new environment in the Advanced Meshing 
Tools workbench
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You will also notice that the New Analysis Case dialog box is 

Figure 19-6  The New Analysis 
Case dialog box

displayed, as shown in Figure 19-6. This dialog box displays a 
selection area with three different types of analysis which are 
Static Analysis, Frequency Analysis, and Free Frequency 
Analysis. Choose the required analysis type from this selection 
box. If you want to keep the selected analysis case as a default 
while launching the workbench again then select the 
Keep as default starting analysis case check box. By default, 
this check box is cleared.  

Creating Mesh on Parts
The basic idea of FEA is to make calculations at only finite numbers of points and then interpolate 
the result for the entire domain. Any continuous object has infinite degree of freedom and it is 
just not possible to solve the problem in that format. Finite element method reduces the degree 
of freedom from infinite with the help of discretization or mesh. The different types of meshing 
tools are discussed next.

Beam Mesher
  Toolbar:	 Meshing Methods > Beam Mesher    

The Beam Mesher tool is used to Mesh the 1D parts which are also known as line bodies. 
In this workbench, you cannot mesh a sketch directly and therefore the sketch must be 
converted into a line body before meshing it. Otherwise, the body to be meshed must be 

a wireframe geometry.

To apply 1D mesh to a line body, choose the Beam Mesher 

Figure 19-7  The Beam Meshing dialog 
box

tool from the Meshing Methods toolbar; the Beam 
Meshing dialog box will be displayed, as shown in 
Figure 19-7. Select the required element type button from 
the Element type area of this dialog box; you will be 
prompted to select the required line body or wireframe 
geometry to  be meshed. Select the required line body 
and specify the required size of element in the Element 
Size edit box. You can also use the Scale button next to 
this edit box to measure the element size from the graphics 
window. 

Select the Minimal mesh check box to generate only 
one element between support vertices for the specified 
mesh size. Select the Sag control check box to control the 
sag of the element. This check box will be inactive if the 
Minimal mesh check box is selected. On selecting the 
Sag Control check box the Sag and Min size edit boxes 
will get activated. 

You can specify the distance between the mesh elements and the geometry in the Sag edit box 
and specify the minimum element size in the Min size edit box. Select the Automatic mesh 
capture check box to capture the external mesh with a given tolerance; the Tolerance edit box 
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under this check box gets activated and the Mesh Part Selector button will be available on the 
right side of this check box. On choosing this button, the Mesh Part Selector selection box will 
be displayed. Select the required mesh part and choose OK.

Surface Mesher
  Toolbar:	 Meshing Methods > Surface Meshing Methods > Surface Mesher     

The Surface Mesher tool is used to Mesh the 2D parts which are also known as surface 
bodies. This tool creates a triangular or quadrangular mesh element on the selected 
surface. This type of mesh is also known as 2D mesh.

To generate surface mesh or 2D mesh on a surface body,

Figure 19-8  The Global Parameters 
dialog box

choose the Surface Mesher tool from the Surface 
Meshing Method sub-toolbar; you will be prompted to 
select the required surface geometry. Select the required 
surface; the Global Parameters dialog box will be 
displayed, as shown in Figure 19-8. By default, the Mesh 
tab is chosen in this dialog box.

Choose the required shape (triangle or quadrangle) of 
mesh element by choosing the required button from the 
Shape area of this dialog box. Select the required radio 
button from the Type area to specify the element type as 
linear or parabolic. You can specify the required size of 
the mesh element in the Mesh size edit box. 

If you choose the Set frontal triangle method button 
from the Shape area, the Absolute sag and Relative sag 
check boxes will be displayed under the Mesh size edit 
box, refer to Figure 19-8. On selecting the Absolute sag

Figure 19-9  The Global Parameters 
dialog box with Quadrangle button 
selected

 
check box, the Absolute sag and Min size edit boxes will 
be displayed. If you select the Relative sag check box, 
the Relative sag edit box will be displayed on its right. 
Now, you can specify the required values in the required 
edit boxes where the Absolute sag is the maximum gap 
between the mesh and the geometry and the Relative sag 
is the ratio between the local absolute sag and the local 
mesh edge length.

If you choose the Set frontal quadrangle method 
button, the Quads only and Default method check 
boxes will be displayed, as shown in Figure 19-9. On 
selecting the Quads only check box the mesh will be 
automatically generated with quadrilateral elements and 
the Default method check box will get deactivated. If you 
select the Default method check box, a drop-down list 
will be displayed on the right side of this check box. You 
can select the required option from this drop-down list.
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Figure 19-10  The Local absolute sag and relative sag

If you choose the Geometry tab from the Global Parameters 

Figure 19-11  The Global Parameters 
dialog box with Geometry tab selected

 
dialog box, the options under this tab will be changed, 
refer to Figure 19-11.

Specify the constraint sag value in the Constraint sag 
edit box. The constraint is a boundary created along 
the edge of a face to avoid creating distorted elements 
across the edge. Figure 19-12 and Figure 19-13 shows the 
constraint created across the edge with too high and  too 
low constraint sag value, respectively. On selecting the 
Constraints independent from mesh size check box the 
Constraint ref size edit box will be displayed under this 
check box. You can specify the required value in this edit 
box. On selecting the Add sharp edges check box, the Add 
sharp edges edit box will be displayed on its right side. You 
can specify the value of the angle computed between two 
tangents on a mesh contour in this edit box. Specify the 
required values in the Min hole size edit box and meshing 
offset in the Offset edit box and choose OK. 

To capture the mesh dynamically for all the constraints, select the Automatic curve capture check 
box; the Tolerance edit box is displayed under this check box. You can specify the maximum 
distance for curve capture in this edit box.

Figure 19-12  The constraint created across the 
edge with too high constraint sag value

Figure 19-13  The constraint created across the 
edge with low constraint sag value
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Advanced Surface Mesher
  Toolbar:	 Meshing Methods > Surface Meshing Methods > Advanced Surface Mesher    

The Advanced Surface Mesher tool is used to mesh the 2D parts or surface bodies. This 
tool creates the triangular or quadrangular mesh elements on the required surface. 
Meshing generated using such elements is also termed as 2D mesh.

To generate the advanced surface mesh on a surface body, choose the Advance Surface Mesher 
tool from the Surface Meshing Method sub-toolbar. On doing so, you will be prompted to select 
the required surface geometry. Select the required surface; the Global Parameters dialog box 
will be displayed, as shown in Figure 19-14. By default, the Mesh tab is chosen in this dialog box.

Figure 19-14  The Global Parameters dialog box displayed after choosing  
the Advanced Surface Mesher tool

Most of the options of this dialog box has already been discussed in the previous topic. To 
generate minimum number of triangular mesh elements, select the Minimize triangles check 
box  and to generate a mesh based on a direction for all elements, select the Directional mesh 
check box. Figure 19-15 and Figure 19-16 shows the mesh created with the Directional mesh 
check box cleared and selected, respectively. If there are strips in the surface model then select 
the Strip optimization check box to generate a regular mesh along that strip. Note that the 
Minimize triangles, Directional mesh and Strip optimization check boxes will remain inactive 
if the Quads only check box is selected.
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Figure 19-15  The mesh created with Directional 
mesh check box cleared

Figure 19-16  The mesh created with Directional 
mesh check box selected

You can specify the value of angle between two corresponding faces in the Angle between faces 
edit box under the Geometry tab. You can also specify the angle between two tangents of the 
contour of mesh in the Angle between curves edit box. Select the Merge during simplification 
check box to improve the quality of the mesh elements in the critical zones by optimizing the 
position of their nodes. On selecting this check box, the Min size edit box under this check box 
gets activated and you can specify the minimum size of an element in this edit box.

Tip
After choosing OK from the Surface mesher and Advance Surface mesher tool, the 
Execution environment will be invoked. You can also mesh and unmesh the part using the 
Mesh the Part and Remove Mesh tools, respectively from the Mesh/Unmesh sub-toolbar of 
the Execution toolbar. You can exit the Execution environment using the Exit tool  from 
the Execution toolbar. 

Octree Triangle Mesh
  Toolbar:	 Meshing Methods > Surface Meshing Methods > Octree Triangle Mesher    

The Octree Triangle Mesher tool is used to

Figure 19-17  The OCTREE Triangle Mesh 
dialog box

 
mesh the 2D parts or surface bodies. This tool 
creates only the triangular mesh elements on 

the selected surface. 

To generate a triangular mesh on a surface body, 
choose the Octree Triangle Mesher tool from the 
Surface Meshing Methods sub-toolbar; you will be 
prompted to select the geometry. Select the required 
geometry; the OCTREE Triangle Mesh dialog box 
will be displayed, as shown in Figure 19-17. Also, you 
will notice a mesh symbol will be displayed at the 
center of the part in the graphics area. By default, 
the Global tab is chosen in this dialog box. Specify 
the size, the absolute sag value, and  the proportional 
sag value of a mesh element in the Size, Absolute sag 
and Proportional sag edit boxes, respectively. The proportional sag is the ratio between the local 
absolute sag and the mesh edge length. Select the required radio button from the Element Type 
area to specify the element type as linear or parabolic triangle.
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To add local meshing parameters to the part, choose the Local tab from this dialog box. Select 
the required parameters from Available specs area; the Add button under this area gets activated. 
Choose the Add button; a new dialog box will be displayed.

If you select the Local size parameter from the Available

Figure 19-18  The Local Mesh Size 
dialog box

 
specs area and then choose the Add button; the Local Mesh 
Size dialog box will be displayed, as shown in Figure 19-18. 
Now, specify the support and the mesh size value and choose 
OK; the OCTREE Triangle Mesh dialog box will be 
displayed again. 

To optimize the quality of mesh for a part, choose the 
Quality tab from this dialog box. Choose the required 
criteria from the Criteria drop-down. The Intermediate 
nodes parameters area will be active only if you choose the 
Parabolic radio button from the Element type area of the Global tab of this dialog box. Specify 
the required Jacobian and warp values in the Jacobian and Warp spinners, respectively to set 
the position of intermediate nodes of the parabolic triangle.

You can specify the maximum size of the element to be ignored during the process of meshing 
in the Geometry size limit edit box in the Details simplification area under the Others tab. 
If the Mesh edges suppression check box  is not selected by default then select this check box 
to remove all the small edges during meshing and specify the required limit in the spinner 
next to it. This spinner remains inactive if the Mesh edges suppression check box is cleared. 
Figure 19-19 and Figure 19-20 show the mesh created on a surface using the Mesh edges 
suppression check box cleared and selected respectively. 

Figure 19-19  Mesh created with the Mesh 
edges suppression check box cleared

Figure 19-20  Mesh created with the Mesh 
edges suppression check box selected

Note
If all the edges of a surface are smaller than the value entered in the Geometry size limit edit box 
then this surface will be ignored by default during the meshing process.

If you select the Global split check box, you can generate the mesh with at least two element 
layers and also mesh edge on a curve connecting two nodes or vertices or a mesh edge on a face 
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connecting two nodes or curves will be split automatically. The Global interior size check box 
remains inactive in case of octree triangle mesh type. You can specify the value of the minimum 
size of the mesh to be refined due to sag specifications in the Min. size for sag specs edit box. 
Specify the maximum number of attempts needed to succeed in meshing in case of a complex 
geometry in the Max. number of attempts spinner. Choose OK to generate the mesh.

Tetrahedron Filler
  Toolbar:	 Meshing Methods > Solid Meshing Methods > Tetrahedron Filler   

The Tetrahedron Filler tool is used to generate tetrahedron mesh from the surface mesh. 
It creates a volume mesh from the surface mesh elements. Here the quality of 3D mesh 
depends on the quality of the 2D mesh.

Note
To generate a solid mesh, make sure the mesh surface is closed in terms of connectivity and the 
surface meshes has no intersection between them.

To generate 3D mesh on a surface body, choose the 

Figure 19-21  The Tetrahedron 
Filler dialog box

Tetrahedron Filler tool from the Solid Meshing Method 
sub-toolbar; the Tetrahedron Filler dialog box will be 
displayed, as shown in Figure 19-21; you are prompted 
to select a 2D mesh part to be filled. Select the required 
closed 2D mesh part; the selected meshed part will be 
displayed in the MeshParts area. You can select any type 
of 2D meshed parts, before that make sure the surface 
mesh is already generated on that 2D part. Select the 
Linear radio button if you want to generate linear meshed 
elements without intermediate nodes which is useful to 
fill a part with straight edges otherwise select the 
Parabolic radio button to generate the parabolic mesh 
elements with intermediate nodes which is useful to fill a 
part with curves from the Element type area of this dialog 
box. Specify the size progression factor in the 
Size progression edit box. By default 2 is specified is this 
edit box. Choose OK to generate the volume mesh.

Figure 19-22 shows a meshed part created using the surface meshed feature and 2D surface 
mesh generated on it. Figure 19-23 shows the same part with volume mesh generated on it using 
the Tetrahedron Filler tool. Note that the parts shown in these figures are cutting views of the 
actual parts as it is mandatory to have closed surface to generate volume mesh using this tool.

Note
If the mesh is not visible once you have applied it then you need to update the mesh. To do so, 
expand the Nodes and Elements sub node of the Finite Element Model node and right-click 
on the mesh that is to be updated. Choose Update Mesh or Update All Mesh from the shortcut 
menu displayed according to the requirement. 
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Tip
To view the cutting view of an element, select the Cutting Plane tool from the Mesh 
Visualization Tools toolbar. 

Figure 19-22  Sphere with 2D mesh Figure 19-23  Sphere with volume mesh 
created using the Tetrahedron Filler

Octree Tetrahedron Mesher
  Toolbar:	 Meshing Methods > Solid Meshing Methods > Octree Tetrahedron Mesher   

The Octree Tetrahedron Mesher tool is used to generate 

Figure 19-24  A Tetrahedron 
mesh element

octree tetrahedron mesh elements on 3D parts. A 
tetrahedron mesh element have 4 vertices, 6 edges, and is 

bounded by triangular faces. In some cases a tetrahedral volume 
mesh can be generated automatically. Figure 19-24 shows an 
example of a tetrahedron mesh element in wireframe. 

To generate Octree Tetrahedron Mesh on a 3D part, choose the
Octree Tetrahedron Mesher tool from the Solid Meshing 
Methods sub-toolbar; the OCTREE Tetrahedron Mesh dialog box 
will be displayed, as shown in Figure 19-25. Also, you will notice 
a mesh symbol displayed at the center of the part in the graphics 
area. The options in this dialog box has been discussed earlier.

Figure 19-25  The OCTREE Tetrahedron Mesh dialog box
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Sweep 3D
  Toolbar:	 Meshing Methods > Solid Meshing Methods > Sweep 3D   

The Sweep 3D tool is used to mesh the parts

Figure 19-26  The Sweep 3D dialog box

 
by generating hexahedron and wedge or prism 
elements. It generates a volume mesh from a 

predefined surface mesh.

To generate hexahedron or prism mesh on a 3D part, 
choose the Sweep 3D tool from the Solid Meshing 
Methods sub-toolbar; the Sweep 3D dialog box will 
be displayed, as shown in Figure 19-26. In this dialog 
box, the Geometry tab is chosen by default. Select 
the 3D part on which you want to generate the sweep 
3D mesh but before that make sure a surface mesh is 
already generated on that 3D part; you are prompted 
to select the limits for the volume mesh. Select the 
bottom face of the part  in the Bottom selection box 
and the top face in the Top selection box, refer to 
Figure 19-27 and Figure 19-28, respectively. These 
faces will work as the limits for the 3D elements. Now, 
specify the angle between two curves to compute the 
guides. The Guides display box displays the total 
number of guides computed. You can compute the guide curves by choosing the Compute but-
ton from the Guides Parameters area. You can also remove the selection of the guide curve by 
choosing the Remove button. On choosing the Impose Guide button from the Guide parameters 
area; the Impose Guide dialog box will be displayed and you can select a particular edge that 
you want to include into the guide computation in the Support selection box. Choose the 
Exclude Guide button; the Exclude Guide dialog box will be displayed. Select the required 
curve to exclude in the Support selection box.

Figure 19-27  Bottom face to be selected Figure 19-28  Top face to be selected

Choose the Mesh tab to specify mesh properties. Choose the Linear or Parabolic radio button 
from the Element Type area to generate linear or parabolic elements, respectively. Note that you 
cannot generate the parabolic mesh elements if the surface part mesh is built with linear elements. 
You can increase the mesh quality, if required, by selecting the Internal and top mesh check 
box from the Smoothing area.
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You can select the distribution type from the Type drop-down list available in the Distribution 
area. If you select the Uniform option, the distance between all the distributed nodes of the 
elements will become same. If you select the Arithmetic and Geometric option, the distance 
between the nodes will be defined by arithmetical and geometrical distribution, respectively. 
On selecting these options, the Size ratio edit box and the Symmetry check box will also be 
activated. You can initialize the layers number field by choosing button next to this edit box. 
You can specify the value of common difference for an arithmetic distribution or the common 
ratio value for a geometric distribution in the Size ratio edit box. Select the Symmetry check 
box if you want a symmetric distribution. You can specify the required number of layers in the 
Layers number edit box.

You can capture the updated bottom face, top face, and lateral meshes to create the solid mesh 
with the help of the Capture area. Specify the tolerance value of the capture in the Tolerance 
edit box, which is the maximum distance for the mesh capture. Choose the Initialize button to 
automatically initialize the tolerance value of the capture. Select the Preview button to visualize 
the captured mesh. Choose OK to generate the mesh. Figure 19-29 shows mesh generated with 
the help of the Sweep 3D tool.

Figure 19-29  Mesh created using the Sweep 3D tool

Mesh Transformations 
The Advanced Meshing Tools environment allows you to generate mesh on a 2D surface or 
on a 3D part as well as to transform it in the required direction with the help of some meshing 
tools provided. These tools works in case of 1D, 2D and 3D mesh parts only. By using these 
tools, if you want to create a 1D or 2D transformed mesh, a surface mesh is requires and for a 
3D transformed mesh, a 3D mesh is required. The mesh transformation tools are discussed next.

Translation Mesher
  Toolbar:	 Mesh Transformation > Transformation sub-toolbar> Translation Mesher   

The Translation Mesher tool is used to create a translation mesh part from an already 
defined mesh part. 
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Choose the Translation Mesher  tool from the

Figure 19-30  The Translation dialog 
box

 
Transformation sub-toolbar; the Translation dialog box 
will be displayed, as shown in Figure 19-30. Also, you will 
be prompted to select the parameters of the translation. 
Select the required part with surface mesh; the selected 
mesh part will be displayed in the MeshParts display box. 
Select the direction of translation in the Direction selection 
box,  refer to Figure 19-31. Specify the distance of the 
direction in the Distance edit box. 

The Capture area enables you to capture the updated mesh 
parts to condense modes. Select the No condensation 
radio button if you do not want to condense the nodes 
of the transformed mesh and the parent mesh. Select 
the Condensation with the parent mesh radio button to 
condense the nodes of the transformed mesh and the parent 
mesh. Select the Condensation with all meshes radio 
button to condense the nodes of the transformed mesh 
part with the updated mesh part.

Choose the Initialize button to automatically initialize the 
tolerance value of the condensation. Note that this button 
remains inactive when the No condensation radio button is 
selected. Choose the Check button to check the tolerance 
value  if there are intersections or interferences between the transformed mesh. Note that this 
button gets activated on choosing the Apply button from this dialog box. Specify the required 
number of repeat translation copies in the Number of copies edit box of the Repeat Translation 
area and choose the OK button. Figure 19-32 shows the mesh after translation.

Figure 19-31 Mesh part and direction to 
be translated

Figure 19-32  Mesh after translation
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Rotation Mesher
  Toolbar:	 Mesh Transformation > Transformation > Rotation Mesher   

The Rotation Mesher tool is used to create a rotated

Figure 19-33  The Translation dialog 
box

 
mesh part from an already defined mesh part. 

To create a rotated mesh part, choose the Rotation Mesher 
tool from the Transformation sub-toolbar; the Rotation 
dialog box will be displayed as shown in Figure 19-33. Also, 
you will be prompted to select the parameters. Select the 
required part with surface mesh; the selected mesh part 
will be displayed in the MeshParts display box. Select the 
axis of rotation in the Axis selection box and specify the 
angle of rotation in the Angle edit box in the Rotation 
Parameters area, refer to Figure 19-34. Specify the required 
parameters and choose OK. The resultant mesh after 
rotation is shown in Figure 19-35.

Note
This transformation follows the rules of associativity 
implying that is if a load is applied to the parent mesh 
part, the same load will be applied automatically to the 
transformed mesh part. 

Figure 19-34 Mesh part and axis of 
rotation

Figure 19-35  Mesh after rotation

Symmetry Mesher
  Toolbar:	 Mesh Transformation > Transformation > Symmetry Mesher   

The Symmetry Mesher tool is used to create a symmetry mesh part from an already 
defined parent mesh part. 
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To do so, choose the Symmetry Mesher tool from the Transformation sub-toolbar; the Symmetry 
dialog box will be displayed, as shown in Figure 19-36. Also, you will be prompted to select the 
required parameters. Select the part with surface mesh; the selected mesh part will be displayed 
in the MeshParts display box. Select the plane of symmetry in the Plane selection box in the 
Symmetry Parameters area, refer to Figure 19-37. Specify the required parameters and choose 
OK. The resultant mesh after symmetry is shown in Figure 19-38. You will notice that the 
symmetric mesh part will be added under the Nodes and Elements node of the specification tree.

Figure 19-36  The Symmetry dialog box

Figure 19-37 Mesh part to be selected Figure 19-38  Mesh after Symmetry

Extrude Mesher with Translation
  Toolbar:      Mesh Transformation >Extrude Transformation > Extrude Mesher with Translation   

The Extrude Mesher with Translation tool is used to extrude a surface mesh with 
translation. To do so, choose this tool from the Extrude Transformation sub-toolbar; the 
Extrusion with Translation dialog box will be displayed, as shown in Figure 19-39. Select 



Introduction to FEA and Generative Structural Analysis	      19-25

the mesh part. Select the axis of translation in the Axis

Figure 19-39  The Extrusion with 
Translation dialog box

 
selection box and specify the start and end limits of extrusion 
in the Start and End edit boxes, respectively. 

Choose the node distribution type from the Type drop-down 
list. If you select the Uniform option then the distance 
between all the distributed nodes will be the same, if you 
select the Arithmetic option then the distance between 
the distributed nodes will be defined by an arithmetical 
distribution, and if you select the Geometric option, the 
distance between the distributed nodes will be defined by 
a geometrical distribution. You can specify the common 
difference value for an arithmetic distribution or the common 
ratio value for a geometric distribution in the Size ratio edit 
box. This edit box is activated only if you select the Arithmetic 
or Geometric as distribution type from the Type drop-down 
list. Specify the number of layers in the Layers number edit 
box. If you want to create a symmetrical distribution then 
you can select the Symmetry check box and choose OK. 
Figure 19-40 shows the mesh part and axis to be selected and 
Figure 19-41 shows resultant mesh extrusion with start limit 
as 20 mm and end limit as 100 mm.

Figure 19-40 Mesh part and axis of 
extrusion

Figure 19-41  Mesh after Extrusion

Extrude Mesher with Rotation
  Toolbar:      Mesh Transformation >Extrude Transformation > Extrude Mesher with Rotation   

The Extrude Mesher with Rotation tool is used to extrude a surface mesh with respect 
to a rotation axis. To do so, choose this tool from the Extrude Transformation sub-toolbar; 
the Extrusion with Rotation dialog box will be displayed, as shown in Figure 19-42. 

Select the surface mesh part. Select the axis of rotation in the Axis selection box and specify 
the start and end angles of extrusion in the Start and End edit boxes, respectively. Also, specify 
the required options and values from the Distribution area and choose OK. Figure 19-43 shows 
the mesh part and axis to be selected and Figure 19-44 shows resultant mesh rotation with start 
limit as 10 deg and end limit as 50 deg.
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Figure 19-42  The Extrusion with Rotation dialog box

Figure 19-43 Mesh part and axis of 
rotation

Figure 19-44  Mesh after rotation

Extrude Mesher with Symmetry
  Toolbar:      Mesh Transformation > Extrude Transformation > Extrude Mesher with Symmetry   

The Extrude Mesher with Symmetry tool is used to extrude a surface mesh with respect 
to a plane of symmetry. To do so, choose the Extrude Mesher with Symmetry tool from 
the Extrude Transformation sub-toolbar; the Extrusion with Symmetry dialog box will 

be displayed, as shown in Figure 19-45. Select the surface mesh part. Select the plane of symmetry 
in the Plane selection box and choose the required options and then choose OK. Figure 19-46 
shows the mesh part and plane to be selected and Figure 19-47 shows resultant mesh symmetry 
extrusion with uniform distribution and 13 layers.
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Figure 19-45  The Extrusion with Symmetry dialog box

Figure 19-46 Mesh part and plane of 
symmetry

Figure 19-47  Mesh after symmetry 
extrusion

Extrude Mesher along Spine
  Toolbar:      Mesh Transformation > Extrude Transformation > Extrude Mesher along Spine   

The Extrude Mesher along Spine tool is used to extrude a mesh along a specific spine 
curve. To do so, choose this tool from Extrude Transformation sub-toolbar; the Extrusion 
along Spine dialog box will be displayed, as shown in Figure 19-48. Select the mesh part 

and select the spine in the Axis selection box. Specify the start and end limits in the Start and 
End edit boxes, respectively. On selecting the Anchor point check box, the display box under 
it gets activated and you can specify the reference point of the spine for the extrusion in this 
display box. Next, choose OK. Figure 19-49 shows the 1D mesh part and spine to be selected 
and Figure 19-50 shows resultant mesh along the spine.
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Figure 19-48  The Extrusion along Spine dialog box

Figure 19-49 Mesh part and spine to be selected Figure 19-50  Resultant mesh along spine

Mesh Intersection and Interference
  Toolbar:	 Mesh Analysis Tools > Intersections / Interferences   

The Intersections / Interferences  tool is used to check the intersections and the 
interferences between the parent mesh and transformed mesh.

To check this interference and intersection choose the Intersections/ Interferences tool from 
the Mesh Analysis Tools toolbar; the Interference Check dialog box will be displayed  as shown 
in Figure 19-51. Specify the required clearance value in the Clearance edit box. Choose the 
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required option from the Mesh Parts drop-down If you want

Figure 19-51  The Interference 
Check dialog box

 
to perform dynamic check, select the Dynamic check check 
box and choose the Apply button; the elements in intersection 
and interference will be displayed in the Number of elements 
area. On the basis of this result, you can edit the mesh by 
double clicking on it from the specification tree. Choose the 
Close button to close the dialog box.

Mesh Operators
In  Advanced Meshing Tools environment, you can perform 
various operation on the mesh created with the help of certain 
tools provided. These tools are discussed below.

Mesh Offset
  Toolbar:	 Mesh Operators > Mesh Offset   

The Mesh Offset tool is used to offset a 2D mesh at a required offset value. To do so, 
choose this tool from the Mesh Operators toolbar; you will be prompted to select a 
meshed part. Select the meshed part, if it is not selected by default; the Mesh Offset 

dialog box will be displayed, as shown in Figure 19-52. Select the 2D mesh, the mesh offset 
direction will be displayed, as shown in Figure 19-53. You can reverse the direction of offset by 
clicking on the arrows displayed on the selected mesh part, refer to Figure 19-53. Specify the 
offset value in the Offset edit box and choose OK. 

Figure 19-52  The Mesh Offset dialog box Figure 19-53  The mesh selected for offset

Note
Sometimes, for complex reference surface mesh, the offset surface mesh may not be created. In such 
cases, you need to reduce the mesh offset value or modify the initial geometry.

Split Quads
  Toolbar:	 Mesh Operators > Split Quads   

The Split Quads tool is used to split quadrangle mesh elements into triangle mesh 
elements. You can only split the linear quadrangle elements using this tool. 
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To do so, choose this tool from the Mesh Operators toolbar; you

Figure 19-54  The Split Quads 
dialog box

 
will be prompted to select the mesh part to be split. Select the 
mesh part to be split; the Split Quads dialog box will be displayed, 
as shown in Figure 19-54. Select the Shortest diagonal radio 
button to choose the shortest distance between both diagonals as 
split. Select the Best quality radio button to choose the diagonal 
with the best quality elements as split. Select the required criteria 
from this dialog box and choose OK. Figure 19-55 displays a quad 
mesh selected from the Split Quads dialog box, splited with the 
shortest diagonal option. 

Figure 19-55  Quads splitted with shortest diagonal option

Generative Structural Analysis workbench
The Generative Part Structural Analysis and the Generative Assembly Structural Analysis allow 
you to quickly perform mechanical analysis for 3D parts and assembly and to accurately calculate 
the displacements and stresses within the part under a variety of loading conditions. They also 
allow the vibration characteristics of parts to be assessed by calculating the natural frequencies 
and the associated mode shapes. This workbench also allows the user to perform an analysis on 
a volume part, any surface part, and any wireframe geometry.

Working with Generative Structural Analysis Workbench
There are two methods to invoke the Generative Structural Analysis workbench of CATIA V5. 
The primary method is by choosing Start > Analysis and Simulation > Generative Structural 
Analysis  from the menu bar. The other method of invoking the Generative Structural Analysis 
workbench is by choosing File > New from the menubar. On doing so, the New dialog box is 
displayed. In this dialog box, select Analysis and choose OK.

On invoking the Generative Structural Analysis workbench, a new analysis environment gets 
started in it. The screen display of the CATIA V5 after invoking the Generative Structural 
Analysis workbench is shown in Figure 19-56. You will notice that the toolbars related to this 
workbench will also be displayed. The tools in these toolbars are discussed later in this chapter.
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Figure 19-56  Screen displayed after starting a new file in the Generative Structural Analysis 
workbench

Applying Physical Properties
You can add or change the physical properties of a shape design by selecting a meshed wireframe 
geometry. There are three types of physical properties in model manager: 1D property, 2D 
property, and 3D property. 

Adding 1D Physical Properties
  Toolbar:	 Model Manager > 1D property > 1D property     

The 1D Property tool allows you to add 1D physical

Figure 19-57  The 1D Property 
dialog box

 
properties to a shape designed by selecting a meshed 
wireframe geometry.

To add 1D physical property, choose the 1D Property tool 
from the Model Manager toolbar; the 1D Property dialog box 
will be displayed, as shown in Figure 19-57. Also, you will be 
prompted to select a mesh part or a 1D geometry. Select the 
required geometry; its name will be displayed in the Supports 
selection box. The Material selection box displays the material 
applied to the part. Select the User-defined material check 
box if you want to select an isotropic material defined by you. 
Select the section type from the Type drop down list. If you 
choose the Component edition button; the Beam Definition 
dialog box will be displayed. You can specify the required 
parameters of the beam and can change the orientation of a 
geometry in this dialog box. You can select a sketched line, a 
point, or an edge in the Orientation geometry selection box 
as directional reference. 
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The Offset drop-down list lets you specify the offset value at each end of the beam. By default, 
the None option is selected in this drop down, hence no offset will be defined. If you choose 
the  Customized option, the Component edition button will be displayed next to the option. 
On choosing this button; the Offset Definition dialog box will be displayed. You can specify the 
required parameters of the beam in this dialog box for both the ends of the beam. 

The Released DOF drop-down list enables you to release or detain the degree of freedom. 
By default, the None option is selected, hence there will be no change in degree of freedom. 
If you choose the Customized option, the Component edition button will be displayed next 
to the option. On choosing this button, the Released Degrees of Freedom dialog box will be 
displayed. You can select the required degree of freedom for start and end points of the beam 
using this dialog box. 

The Variable beam factors check box allows you to create a linear approximation of variable cross 
section beams. On selecting this check box, the Multiplication Factors on Extremities area will 
be displayed under this check box. By using options in this area, you can define the scaling factor 
on each side of the beam. After specifying the required parameters, choose OK. Figure 19-58 
displays a line body converted into cylindrical section beam with the 1D Property tool. 

Figure 19-58  A cylindrical beam with 1D property

Note
You can select the meshed element only from the specification tree and not from the graphics window. 

Adding 2D Physical Properties
  Toolbar:	 Model Manager > 2D property > 2D property   

The 2D Property tool allows you to add 2D physical properties to a shape design geometry.

To add 2D physical properties to a shape design, choose the 2D Property tool from the 
Model Manager toolbar; the 2D Property dialog box will be displayed, as shown in Figure 19-
59. Also, you will be prompted to select a 2D meshed surface. Select the surface and specify the 
required thickness in the Thickness edit box. After specifying the thickness, specify the offset 
value in the Offset edit box and choose OK. Figure 19-60 displays a surface body on applying 
the 2D property with an offset of 4mm.
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Figure 19-59  The 2D Property 
dialog box

Figure 19-60  A surface with 2D property 
and 4mm Offset 

Adding 3D Physical Properties
  Toolbar:	 Model Manager > 3D property   

The 3D Property tool allows you to add 3D physical

Figure 19-61  The 3D Property 
dialog box

 
properties to a shape design geometry.

To add 3D physical properties to a shape design, choose the 
3D Property tool from the Model Manager toolbar; the 3D 
Property dialog box will be displayed, as shown in Figure 
19-61. Also, you are prompted to select a part or mesh part. 
Select the part; the name of the selected part will be displayed 
in the Supports selection box. You can define the orientation 
by using the Orientation drop-down list. By default, the None 
option is selected in this drop-down list. 

If you choose the By Axis option, the Component edition button will be displayed next to the 
option. On choosing this button, the Orientation Definition dialog box will be displayed. Choose 
the required axis system and choose OK from this dialog box. If you choose the By Surface 
option, the Component editor button will be displayed next to the option. On choosing this 
button; the Orientation Definition dialog box will be displayed. Select the required surface for 
orientation in the Surface selection box. Also, you can select a line or any edge in the Direc-
tion selection box for the direction of orientation and choose OK from this dialog box. After 
specifying the required options, choose OK from the 3D property dialog box.

Creating virtual parts
Virtual parts represent bodies for which no geometry model is available but which play an im-
portant role in the structural analysis of a single part or an assembly system. Virtual parts are 
used to transmit action at a certain distance.
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Applying Smooth Virtual Part
  Toolbar:	 Virtual Parts > Virtual Parts > Smooth Virtual Part    

A smooth virtual part is a rigid body which connects a

Figure 19-62  The Smooth 
Virtual Part dialog box

 
specified point to a specified part geometry. It behaves 
as a mass-less rigid object which will softly transmit 

masses, restraints, or loads applied at the geometry. 

To apply smooth virtual part, choose the Smooth Virtual Part 
tool from the Virtual Parts sub-toolbar; the Smooth Virtual Part 
dialog box will be displayed, as shown in Figure 19-62. Select a 
face or a particular entity as support; its name will be displayed 
in the Supports selection box. Select the required handler 
point in the Handler selection box and choose OK. Note that 
a handler point is that point upto which the virtual part will be 
created. Figure 19-63 displays a part with smooth virtual part 
applied on a part.

Figure 19-63  The smooth virtual part applied on a part 

Applying Contact Virtual Part
  Toolbar:	 Virtual Parts > Virtual Parts > Contact Virtual Part    

A contact virtual part is also a rigid body which connects a specific point to specific part 
geometry. It behaves as a mass-less rigid object which will softly transmit masses, restraints, 
or loads applied at the geometry. 

To apply contact virtual part, choose the Contact Virtual

Figure 19-64  The Contact Virtual 
Part dialog box

 
Part tool from the Virtual Parts sub-toolbar; the Contact 
Virtual Part dialog box will be displayed, as shown in 
Figure 19-64. Select a face or a particular entity as support; 
its name will be displayed in the Supports selection box. 
Select the required handler point in the Handler selection 
box. Specify the required clearance value in the Clearance 
edit box and choose OK. Figure 19-635 displays a part 
with contact virtual part applied on a part.
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Figure 19-65  The contact virtual part applied on a part 

Note
When several virtual parts share same handler point then only one finite element node will be 
generated.

Applying Rigid Virtual Part
  Toolbar:	 Virtual Parts > Virtual Parts > Rigid Virtual Part    

A rigid virtual part is a rigid body which connects a

Figure 19-66  The Rigid Virtual 
Part dialog box

specific point to some specific part geometry by 
stiffening the deformable part to which it is 

attached. It behaves as a mass-less rigid object which will 
softly transmit masses, restraints, or loads applied at the 
geometry. 

To apply rigid virtual part, choose the Rigid Virtual 
Part tool from the Virtual Parts sub-toolbar; the Rigid 
Virtual Part dialog box will be displayed, as shown in 
Figure 19-66. Select a face or a particular entity as support; 
its name will be displayed in the Supports selection box. 
Select the required handler point in the Handler selection 
box and choose OK. Figure 19-67 displays a part with rigid 
virtual part applied on a part.

Figure 19-67  The rigid virtual part applied on a part 

Applying Rigid Spring Virtual Part
  Toolbar:	 Virtual Parts > Virtual Parts > Rigid Spring Virtual Part    

A rigid spring virtual part is an elastic body which connects a specific point to a specific 
geometry by stiffening the deformable part to which it is attached, It behaves as a six 

degree of freedom spring in series with a mass-less rigid body which will stiffly transmit masses, 
restraints, or loads applied at the handle point.
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To apply rigid spring virtual part, choose the Rigid Spring Virtual Part tool from the Virtual Parts 
sub-toolbar; the Rigid Spring Virtual Part dialog box will be displayed, as shown in Figure 19-68. 
Select a face or a particular entity as support; its name will be displayed in the Supports selection 
box. Select the required handler point in the Handler selection box. 

You can select the required type of axis system from the Type drop-down list in the Axis System 
area of this dialog box. By default, Global is selected. As a result, the resultant force vectors will 
be converted as relative to the global coordinate system. If you select the User axis system, the 
components of the resultant force vector will be converted as relative to the specified coordinate 
system. Also, on selecting this option from the Type drop-down list; the Current axis selection 
box will be displayed. Select the required existing axis in this selection box. 

Figure 19-68  The Rigid Spring Virtual Part dialog box

Specify values for the six degrees of freedom spring constants in the required Translation Stiff-
ness and Rotation Stiffness edit boxes and choose OK. Figure 19-69 displays a part with rigid 
spring virtual part applied on a part.

Figure 19-69  The rigid spring virtual part applied on a part 
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Applying Smooth Spring Virtual Part
  Toolbar:	 Virtual Parts > Virtual Parts > Smooth Spring Virtual Part    

A smooth spring virtual part is an elastic body which connects a specific point to a specific 
geometry by stiffening the deformable part to which it is attached. It also behaves as a 
six degree of freedom spring in series with a mass-less rigid body which will softly transmit 

masses, restraints, or loads applied at the handle point.

To apply smooth spring virtual part, choose the Smooth Spring Virtual Part tool from the 
Virtual Parts sub-toolbar; the Smooth Spring Virtual Part dialog box will be displayed, as 
shown in Figure 19-70. Select a face or a particular entity as support; its name will be displayed 
in the Supports selection box. Select the required handler point in the Handler selection box. 
Specify the required axis system and values of degrees of freedom and choose OK. Figure 19-
6971 displays a part with smooth spring virtual part applied on a part.

Figure 19-70  The Smooth Spring 
Virtual Part dialog box

Figure 19-71  The smooth spring 
virtual part applied on a part 

Applying Periodicity Conditions
  Toolbar:	 Virtual Parts > Periodicity Condition    

The periodicity conditions enable you to perform analysis on a solid section of a periodic 
part. This solid section represents a cyclic period of the entire part. 

To apply this condition, choose the Periodicity Condition tool from the Virtual Parts toolbar; 
the Periodicity Condition dialog box will be displayed, as shown in Figure 19-72. Choose the 
faces of the part to be used for generating periodicity of the part section, refer to Figure 19-73 
and Figure 19-74. Choose OK to add periodicity conditions. 
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Figure 19-72  The Periodicity Condition dialog box

Figure 19-73  The periodicity condition 
applied on a cyclic part 

Figure 19-74  The periodicity condition 
applied on a regular part 

Note
To use periodicity conditions, make sure the geometry is continuous as well as the applied restraints 
and loads are periodic. Also, the geometry needs to be regular at the place the section is created. 

Applying RESTRAINS 
The Generative Structural Analysis workbench of CATIA V5 allows you to restrict the degrees 
of freedom of a component or a group of components. This workbench provides various types of 
restraints to restrict the degree of freedom of a component. These restraints are discussed next. 

Applying Clamp
  Toolbar:	 Restraints > Clamp    

In the Generative Structural Analysis workbench, the Clamp tool is used to restrict the 
degree of freedom of a part with respect to the surface or curve geometries on which 
clamp is applied.

To apply clamp to a part or geometry, choose the Clamp tool

Figure 19-75  The Clamp dialog box

 
from the Restraints toolbar; the Clamp dialog box will be 
displayed, as shown in Figure 19-75. Select a face of the part; 
its name will be displayed in the Supports selection box. Next 
specify the name of the clamp in the Name edit box of this 
dialog box and choose OK. The clamp restrain gets added, 
as shown in Figure 19-76.
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Figure 19-76  The Clamp added
On selecting the required geometry to apply clamp, the Select Mesh Parts button next to the 
Supports selection box gets activated. This button allows you to choose one mesh part from all 
the activated or deactivated mesh parts associated to this support. On selecting this button; the 
Mesh Parts dialog box is displayed. This dialog box displays the mesh parts selected by you. 

Applying Surface Slider
  Toolbar:	 Restraints > Mechanical Restraints > Surface Slider    

The Surface Slider tool is used to add a slider constraint joint between two surfaces. Out 
of which one of the surfaces is a rigid surface. Hence, one direction of the surface is 
restrained. It can only slide along the coinciding rigid surface.

To apply surface slider restraint to a part or geometry, choose

Figure 19-77  The Surface 
Slider dialog box

 
the Surface Slider tool from the Mechanical Restraints 
sub-toolbar; the Surface Slider dialog box will be displayed, as 
shown in Figure 19-77. Select a face of the part; its name will be 
displayed in the Supports selection box. Next specify the name 
of the clamp in the Name edit box of this dialog box and choose 
OK. The surface slider restraint gets added as shown in 
Figure 19-78. Also, you will notice that the Surface Slider 
sub-node gets added under the Restraints node of the Analysis 
Manager tree. 

Figure 19-78  The surface slider restraint 

Applying Slider
  Toolbar:	 Restraints > Mechanical Restraints > Slider    

The Slider tool is used to add a slider restraint to the handle points of virtual parts. It 
forces them to slide along a given axis so that one of the two handle points and the sliding 
axis are fixed.
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To apply Slider restrain to a part or geometry, first you need

Figure 19-79  The Slider dialog box

 
to create a virtual part as this tool handles only the points of 
the virtual parts. The creation of virtual parts is later discussed 
in this chapter. To apply Slider restrain, choose the Slider 
tool from the Mechanical Restraints  sub-toolbar; the Slider 
dialog box is displayed as shown in the Figure 19-79. Select 
the created virtual part as a support in the Support selection 
box. On doing so, a small cuboid gets attached to the virtual 
part indicating a slider restraint. Select the type of axis system 
with respect to which the slider restraint will be applied as 
Global or User from the Type drop-down list in the Axis 
System area of this dialog box. 

On selecting the User option from the Type drop-down list, 
the Current axis selection box and the Local orientation 
drop-down list gets displayed in the Axis System area. You

Figure 19-80 The slider restraint

can select the axis of the reference axis system in the Current 
axis selection box. Note that this reference axis system must 
be created in the part document. You can select the orientation 
of the user axis system as Cartesian, Cylindrical or Spherical 
from the Local orientation drop-down list. You can enter the 
values of the sliding direction relative to the axis system in  
the X, Y and Z edit boxes of the Released Direction area.  
You will notice that a Slider sub-node gets added under the 
Restraints node of the Analysis Manager tree. Figure 19-80 
shows a master rod with slider restraint and a smooth virtual 
part. 

Applying Sliding Pivot
  Toolbar:	 Restraints > Mechanical Restraints > Slider Pivot    

The Slider Pivot tool is used to add slider restraints to

Figure 19-81  The Sliding 
Pivot dialog box

a 
cylindrical part to the handle points of virtual parts. It 
forces them to constrain along a given axis so that they 

translate and rotate along that axis.

To apply the sliding pivot restraint to a part or geometry, 
choose the Sliding Pivot tool from the Mechanical Restraints 
sub-toolbar; the Sliding Pivot dialog box will be displayed, as 
shown in Figure 19-81. Select the required virtual part with 
respect to which you want to apply this restrain in the Supports 
selection box. Next specify the name of the restraint in the 
Name edit box of this dialog box and choose OK. On doing 
so, a small red cylindrical object gets attached to the virtual 
part indicating slider pivot restraint, as shown in Figure 19-82. 
Also, you will notice that a Sliding Pivot sub-node gets added 
under the Restraints node of the Analysis Manager tree. The 
options in the Axis System and Released Direction areas have 
already been discussed.
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Figure 19-82  The sliding pivot restrain

Applying Ball Joint
  Toolbar:	 Restraints > Mechanical Restraints > Ball Joint    

The Ball Joint tool adds a spherical joint restraint to the points of virtual parts constraining  
the part to rotate around a fixed point. 

To apply ball joint restraint to a part or geometry, choose the

Figure 19-83  The Ball Joint 
dialog box

 
Ball Joint tool from the Mechanical Restraints sub-toolbar; the 
Ball Joint dialog box will be displayed, as shown in Figure 19-83. 
Select the virtual part with respect to which you want to apply 
this restraint in the Supports selection box and specify the name of 
the restraint in the Name edit box of this dialog box and choose 
OK. On doing so, a small ball joint icon gets attached to the 
virtual part indicating the ball joint restraint, as shown in 
Figure 19-84. 

Figure 19-84  The ball joint restraint

Applying Pivot
  Toolbar:	 Restraints > Mechanical Restraints > Pivot    

The Pivot tool adds a conical join restraint to the points of virtual parts. It constraints 
the point to rotate around a given fixed axis. This joint is also known as hinge joint which 
allows a relative rotation between two points.
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To apply the pivot restraint to a part or geometry, choose the Pivot tool from the Mechanical 
Restraints sub-toolbar; the Pivot dialog box will be displayed, as shown in Figure 19-85. Select 
the virtual part with respect to which you want to apply this restraint in the Supports selection 
box and specify the name of the restraint in the Name edit box of this dialog box and choose 
OK. On doing so, a pivot icon gets attached to the virtual part which shows the pivot restraint, 
as shown in Figure 19-86. 

Figure 19-85  The Pivot dialog box Figure 19-86  The pivot restraint

Applying User-defined Restraint
  Toolbar:	 Restraints > Advance Restraints > User-defined Restraint    

The user-defined restraints are generic restraints which

Figure 19-87  The User-defined 
Restraint dialog box

 
allow you to fix any combination of nodal degrees of 
freedom which is available on an arbitrary geometry. 

To apply the user-defined restraint to a part or geometry, 
choose the User-defined Restraint tool from the Advance 
Restraints sub-toolbar of the Restraints toolbar; the 
User-defined Restraint dialog box will be displayed, as shown 
in Figure 19-87. Select the virtual part with respect to which 
you want to apply this restraint in the Supports selection box 
and specify the name of the restraint in the Name edit box 
of this dialog box. Next, choose OK; a small  user-defined 
restraint icon will get attached to the virtual part which shows 
the user-defined restraint, as shown in Figure 19-88. 

You can also select the desired type of axis system from the Type 
drop-down available in the Axis System area of this dialog box. 
By default, the Global axis system is selected in this drop-down 
list. As a result, the degree of freedom directions will translate 
as relative to the fixed global coordinate system. Select the Implicit axis system from the Type 
drop-down to translate the degree of freedom directions as relative to a local variable coordinate 
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system whose type will depend on the support geometry. On selecting the User axis system 
from this drop-down list, the direction of the degree of freedom will be relative to the specified 
axis system. Their translation will further depend on the axis type and orientations that can be 
selected from the Local orientation drop-down and will be available only on selecting this option.

Also, you can restrain the degree of freedom by checking and clearing the  Restrain Translation 
and Restrain Rotation check boxes from the User-defined Restraint dialog box.

Figure 19-88  The user-defined restraint applied to a part

Applying Isostatic Restraint
  Toolbar:	 Restraints > Advance Restraints > Isostatic Restraint    

The Isostatic Restraints are statically definite restraints, that allow you to simply restrain 
a body to a particular location. 

To apply the isostatic restraints to a part or geometry, choose the

Figure 19-89  The Isostatic 
Restraint dialog box

 
Isostatic Restraint tool from the Advance Restraints sub-toolbar; 
the Isostatic Restraint dialog box will be displayed, as shown in 
Figure 19-89.

Select the part that is to be restrained statically and specify the 
name of restraint in the Name edit box of the Isostatic Restraint  
dialog box. Next, choose OK; the Isostatic Restraints will be 
added to the specification tree with the name specified in the 
Isostatic Restraint dialog box.

Applying Loads
The main goal of Generative Structural Analysis is to examine how a structure or component will 
respond to certain loading conditions. Specifying the proper loading conditions is, therefore, a 
key step in the analysis. The Generative Structural Analysis environment of CATIA allows you 
to apply loads on the model in different ways.
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Applying Pressure
  Toolbar:	 Loads > Pressure    

The pressure is the force applied per unit area in a direction perpendicular to the surface 
of the model. They are intensive loads that represent scalar pressure fields applied to the 
surface of a geometry.

To apply the pressure load on a surface, choose the Pressure tool from the Loads toolbar; the 
Pressure dialog box will be displayed, as shown in Figure 19-90 and you will be prompted to 
select a face. Select the face from the geometry area; the name of selected face will be displayed 
in the Supports selection box. Specify the pressure value in the Pressure edit box. By choosing 
the Data Mapping check box, you can use the data mapping functionality in which you can 
import load descriptions in the form of text or Excel files. Choose OK to apply pressure. 
Figure 19-91 shows the surface to be selected to apply pressure and Figure 19-92 shows the part 
with pressure applied to the selected surface. 

Figure 19-90  The Pressure dialog box

Figure 19-91  Surface to be selected to 
apply pressure

Figure 19-92  Pressure applied to the  
selected surface

Applying Distributed Force
  Toolbar:	 Loads > Forces > Distributed Force    

The distributed forces are those forces which are statically equivalent to a given resultant 
force at a given point or area. It is not aimed to uniformly distribute this force on the 
selected supports.
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To apply this force on a face or surface, choose the Distributed Force tool from the Forces 
sub-toolbar; the Distributed Force dialog box will be displayed, as shown in Figure 19-93. Also, 
you are prompted to select a support as a vertex, a face, or a virtual part to apply this force. 
Select the required support from the geometry area and specify the value of the distributed 
force, as shown in Figure 19-94. 

Figure 19-93  The Distributed Force dialog box

You can select the required type of axis system form the Type drop-down list in the Axis System 
area of this dialog box. By default, the Global axis system is selected. As a result, the resultant 
force vectors will be converted as relative to the global coordinate system. If you select the User 
axis system, the components of the resultant force vector will be converted as relative to the 
specified coordinate system. Also, on selecting the User option from the Type drop-down list, 
the Current axis display box and the Orientation drop-down list will be displayed in the Axis 
System area of this dialog box.

You can define the force vector by specifying the force magnitude in the Norm edit box. Also, 
you can specify the force vectors in the X, Y and Z edit boxes in the Force Vector area. Select 
the required handler point in the Handler selection box and choose OK.

Figure 19-94  The Distributed force applied to a selected surface
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Note
To select the User axis system, you must activate it by selecting it from the specification tree. On 
activating, its name will be displayed in the Current axis selection box.

Applying Moment
  Toolbar:	 Loads > Forces > Moment    

The moment load tends to overturn or bend the axis of rotation of a model angularly. It 
is the ability of the force to twist or turn the object about an axis.

To apply moment, choose the Moment tool from the Forces sub-toolbar; the Moment dialog 
box will be displayed, as shown in Figure 19-95. Select the required surface and specify the other 
required options and choose OK. Figure 19-96 shows the moment applied to a part.

Figure 19-95  The Moment dialog box Figure 19-96  Moment applied to a part

Applying Bearing Load
  Toolbar:	 Loads > Forces > Bearing Load    

A bearing load is a simulated contact load applied to a cylindrical surface. To apply a 
bearing load to a surface, choose the Bearing Load tool from the Forces sub-toolbar; the 
Bearing Load dialog box will be displayed, as shown in Figure 19-97. Select the support 

surface from the geometry area; the name of support surface will be displayed, in the Supports 
selection box.

You can specify the angle on which the forces will be distributed in the Angle edit box. The 
Orientation drop-down allows you to distribute forces in two ways: radial and parallel. If you select 
the Radial option then all the force vectors at the mesh nodes will orient normal to surface. If 
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you choose the Parallel option then all the force vectors will orient parallel to the surface. Choose 
the profile type from the Type drop-down in the Profile area. Specify the force distribution as 
Inward and Outward from the Distribution drop-down and choose OK. Figure 19-98 shows a 
part with bearing load applied on it.

Figure 19-97  The Bearing Load dialog box Figure 19-98  Bearing Load applied to a part

Applying Acceleration
  Toolbar:	 Loads > Body Mass Forces > Acceleration    

The acceleration are the intensive loads which represents mass body force fields of uniform 
magnitude applied on the parts. It is also known as the net result of any or all forces that 
acts on a part. To apply acceleration to a part, choose the Acceleration tool from the 

Body Mass Forces sub-toolbar; the Acceleration dialog box will be displayed, as shown in 
Figure 19-99. 

Select the support surface from the geometry area; the name of the surface will be displayed in 
the Supports selection box. Next, specify the required options and choose OK. Figure 19-100 
shows a part with acceleration applied on it.

Tip
You can select several supports in a sequence to apply the acceleration to all the supports 
simultaneously.
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Figure 19-99  The Acceleration dialog 
box

Figure 19-100  Acceleration applied to a part

Applying Rotation Forces
  Toolbar:	 Loads > Body Mass Forces > Rotation Force    

The rotation forces are accelerated loads which represent mass body force fields generated 
by the rotational motion applied to a part. To apply a rotational force, to a part, choose 
the Rotation Force tool from the Body Mass Forces sub-toolbar; the Rotation Force 

dialog box will be displayed, as shown in Figure 19-101. 

Select the support surface from the geometry area; the name of the support surface will be 
displayed in the Supports selection box. Click once in the Rotation Axis selection box and 
choose the rotation axis. Specify the value of the angular velocity and angular acceleration 
in the Angular Velocity and Angular Acceleration edit boxes, respectively and choose OK. 
Figure 19-102 displays a part with rotational force applied to it.

Figure 19-101  The Rotation Force 
dialog box

Figure 19-102  Rotation force  applied to a part
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Applying Line Force Density
  Toolbar:	 Loads > Force Densities > Line Force Density    

The line force densities are the intensive loads which represent the line resistance fields 
of uniform magnitude applied to various geometries. 

To apply the line force density to a part, choose the Line Force Density tool from the Force 
Densities sub-toolbar; the Line Force Density dialog box will be displayed, as shown in 
Figure 19-103. Select a line body or an edge of a part as support and specify the required 
options from the dialog box and choose OK. Figure 19-104 shows a part with its edge selected 
as support to apply line force density.

Figure 19-103  The Line Force Density 
dialog box

Figure 19-104  Line force density applied to 
an edge of a part

Applying Surface Force Density
  Toolbar:	 Loads > Force Densities > Surface Force Density    

The surface force densities are the intensive loads which represent the surface resistance 
fields of uniform magnitude applied to the curve geometries. 

To apply the surface force density on a part, choose the Surface Force Density tool from the 
Force Densities sub-toolbar; the Surface Force Density dialog box will be displayed, as shown 
in Figure 19-105. Select a surface body or a face of a part as support and specify the required 
options from the dialog box and choose OK. Figure 19-106 shows a part with its upper face 
selected as support to apply surface force density.
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Figure 19-105  The Surface Force 
Density dialog box

Figure 19-106  Surface force density applied 
to a face of a part

Applying Volume Force Density
  Toolbar:	 Loads > Force Densities > Volume Force Density    

The volume force densities are intensive loads which represent the volume body  force 
fields of uniform magnitude applied to the parts. 

To apply the volume force density to a part, choose the Volume Force Density tool from the 
Force Densities sub-toolbar; the Volume Force Density dialog box will be displayed, as shown in 
Figure 19-107. Select a part as support and specify the required options from the dialog box and 
choose OK. Figure 19-108 shows a part to be selected as support to apply volume force density.

Applying Force Density
  Toolbar:	 Loads > Force Densities > Force Density    

The Force Density tool is used to create the equivalent of the existing force, surface 
force, and volume force densities. To do so, choose the Force Density tool from the Force 
Densities sub-toolbar; the Force Density Defined by Force Vector dialog box will be 

displayed, as shown in Figure 19-109. Select the required part and specify the required parameters 
in this dialog box and choose OK.
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Figure 19-107  The Volume Force 
Density dialog box

Figure 19-108  Volume force density applied 
to a part

Figure 19-109  The Force Density Defined by Force Vector dialog box
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Applying Enforced Displacement
  Toolbar:	 Loads >  Enforced Displacement    

The enforced displacement loads are those loads that are applied to support geometries. 
As a result, the subsequent analysis will assign a non-zero value to the displacement in 
previously restrained direction. 

To apply the enforced displacement, choose the Enforced Displacement tool from the Loads 
toolbar; the Enforced Displacement dialog box will be displayed, as shown in Figure 19-110. 
Select the required restraint in the Restraint selection box and specify the translation and rotation 
values in the Translation and Rotation edit boxes. Choose OK. The enforce displacement will 
be attached to the selected restraint, refer to Figure 19-1111.

Note
Make sure you have entered non-zero values only for those degrees of freedom which have been 
fixed by the associated restraint object. Non-zero values for any other degree of freedom will be 
ignored by the program.

Figure 19-110  The Enforced 
Displacement dialog box

Figure 19-111  Enforced displacement applied 
to a part

Applying Temperature Field
  Toolbar:	 Loads > Temperature Field > Temperature Field   

The Temperature Field tool is used to apply temperature constant to a part. To do so, 
choose the Temperature Field tool from the Temperature Field sub-toolbar; the 
Temperature Field dialog box will be displayed, as shown in Figure 19-112. Select the 

required part to apply the temperature field; you will notice a T sign gets attached to the selected 
part. Specify the temperature in the Temperature edit box and choose OK. Figure 19-113 
displays a part with temperature field applied on it.
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Figure 19-112  The Temperature 
Field dialog box

Figure 19-113  Temperature field applied to 
a part

Computing the analysis Result
  Toolbar:	 Compute > Compute   

The Compute tool is used to compute the result for the

Figure 19-114  The Compute 
dialog box

 
analysis. To do so, choose the Compute tool from the 
Compute sub-toolbar; the Compute dialog box will be 

displayed, as shown in Figure 19-114. Choose the required 
operation to compute from the drop-down available in this dialog 
box and choose OK. After choosing the OK button, the Computing 
process window will be displayed, refer to Figure 19-115.  Once the 
computing process completes, the Computation Resources 
Estimation message box will be displayed, refer to Figure 19-116. 
To continue the computation, choose the Yes button from this 
dialog box. Note that you can view the required analysis results 
with the help of tools available in the Image toolbar.

Figure 19-115  The Computing process window

Figure 19-116  The Computation Resources Estimation message box
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Note
After choosing OK from the Compute dialog box if a warning message box is displayed with several 
warnings related to the conditions you have applied, choose OK from this dialog box to continue.

Generating the analysis Report
  Toolbar:	 Analysis Results > Report > Generate Report   

The Generate Report tool is used to generate the complete report of the preprocessor, 
solver, and postprocessor data of the problem after completing the solution. To generate 
the complete report, choose the Generate Report tool from the Report sub-toolbar of  

the Analysis Result toolbar; the Report Generation dialog box will be displayed, as shown in 
Figure 19-117. Specify the required output directory path in the Output directory edit box with 
the help of the Browse button next to it and choose OK. On doing so, the reporting process 
window will be displayed. After completing the process, stress analysis report will be displayed 
on the internet browser.

Figure 19-117  The Report Generation dialog box

Animating Results
  Toolbar:	 Analysis Tools > Animate   

The Animate tool is used to generate the animation

Figure 19-118  The Animation dialog 
box

 
view of the results generated in the postprocessing 
phase. This tool remains active only when the 

valid solution is available. On choosing the Animate tool 
from the Analysis Tools toolbar; the Animation dialog 
box will be displayed, as shown in Figure 19-118.  The 
options in this dialog box are used to play, stop, and set 
the speed of animation. Specify the required parameters 
and choose OK. The model will start animating on the 
basis of the selected parameters. 
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Tutorials
 Tutorial 1

In this tutorial, you will analyze the effect of loads on the spring shown in Figure 19-119. The 
spring is fixed at one end and the load is applied on the other end. Under the given load and 
constraints you will perform static analysis on this spring. The part file of this tutorial can be 
downloaded from www.cadcim.com.  The boundary conditions are given within the tutorial steps 
only.									         (Expected time: 1hr)

Figure 19-119  Model of the spring

The following steps are required to complete the tutorial.

a.	 Download and import the input file to the Generative Structural Analysis workbench.
b.	 Generate the mesh.
c.	 Apply constraints and loads.
d.	 Compute the analysis.
e.	 Analyze the results.
f.	 Generate the analysis report.
g.	 Save the analysis.

Downloading the Part File
Before starting the tutorial, you need to download the spring part file for this tutorial from the 
CADCIM website.

Download the file c19_catia_tut1.zip file from www.cadcim.com. The path of the file is as follows: 
Textbook > CAD/CAM > CATIA > CATIA V5-6R2017 for Designers > Input files.

Starting the Static Analysis
After extracting the input file, you need to open the spring part file in CATIA. 

1.	 After opening the file in CATIA, start a new file in the Generative Structural Analysis 
workbench by choosing Start > Analysis & Simulation > Generative Structural Analysis. 
The New Analysis Case dialog box will be displayed along with the imported spring part 
in the Generative Structural Analysis workbench.
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2.	 Choose the Static Analysis option from the New Analysis Case dialog box and choose OK. 

The Generative Structural Analysis workbench along with various analysis tools will be displayed. 
Also, you will notice that a mesh icon will be displayed at the center of the spring.

Note
On invoking this workbench if a warning message box is displayed informing that the material is 
not properly defined on the part, choose OK from this warning message box to continue.

Applying the Material
Next, you need to apply the material to the spring.

1.	 Click once on the spring from the graphics area and invoke the Library (Read only) dialog 
box by choosing the Material on Analysis Connection tool from the Material on Analysis 
Connection toolbar.

2.	 Make sure the Metal tab is selected in this dialog box.

3.	 Select the Brass metal to apply on the imported spring and choose the Apply Material 
button from this dialog box to apply the material to the spring and choose OK. 

Generating the Mesh 
Next, you need to generate the mesh on the spring.

1.	 Invoke the OCTREE Tetrahedron Mesh dialog box by double clicking on the OCTREE 
Tetrahedron Mesh sub-node of the Nodes and Elements node.

2.	 Enter 5 mm in the Size edit box and specify 1 mm in the Absolute sag edit box of the Global 
tab, and keeping the other values as default, choose OK.

Applying Restraints and Loads to the Spring
Next, you need to apply boundary constraints and loads on the spring.

1.	 Choose the Clamp tool from the Restraints toolbar; the Clamp dialog box is displayed.

2.	 Choose the inner face of the holes at the bottom face of the spring base, as shown in Figure 
19-120 and then choose the OK button from the Clamp dialog box; the clamp restraint is 
applied, refer to Figure 19-121.

After applying the material and restraints to the spring, you need to apply load on the holes at 
the top face of the spring.

1.	 Choose the Distributed Force tool from the Force sub-toolbar of the Loads toolbar; the 
Distributed Force dialog box is displayed.
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Figure 19-120  The holes to be selected Figure 19-121  The clamp restraint applied to 
the base holes

2.	 Select the inner face of the holes on the top face of the spring from the graphics area, refer 
to Figure 19-122. The name of the selected faces of holes are displayed in the Supports 
selection box 

3.	 Enter -100 N in the Z edit box in the Force Vector area and choose OK. Figure 19-123 
shows the spring after applying the load.

Figure 19-122  The holes to be selected Figure 19-123  Load applied on the holes of the 
upper face of the spring

Computing the Analysis
After applying all the restraints, loads, and mesh you need to solve the analysis for the spring.

1.	 Choose the Compute tool from the Compute sub-toolbar; the Compute dialog box is 
displayed. Select the All option from the drop-down list available in this dialog box if not 
selected by default  and choose OK from this dialog box. The Computing  process window 
and the Computation Status message box are displayed. 

After the computing process is over, the Computation Resources Estimation message box is 
displayed.

2.	 Choose Yes from this message box. The Computing  process window and Computation 
Status message box are displayed again. 
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Once the processing is over; the result is computed and you can view the results using various 
tools available in the Image toolbar. 

Analyzing the Result
Now, after the computation process is completed, you will analyze the result.

1.	 Choose the Deformation tool from the Image toolbar; the deformation generated in the 
model is displayed in the graphics area, refer to Figure 19-124. 

Figure 19-124  The deformation in the spring

2.	 Choose the Von Mises Stress tool from the Image toolbar; the Von Mises Stress generated 
in the model is displayed in the graphics area, refer to Figure 19-125. 

Figure 19-125  The Von Mises Stress generated  in the spring
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Generating the Analysis Report
Next, you will generate the analysis report of the result.

1.	 Choose the Generate Report1 tool from the Report sub-toolbar of the Analysis Report 
toolbar; the Report Generation dialog box is displayed. Specify the location to save the 
report and choose OK. The analysis report is generated in .html format and is displayed in 
your default internet browser.

After completing the study procedure and generating the analysis report, you need to save the 
model.

Saving and Closing the File
1.	 Choose the Save button from the Standard toolbar to invoke the Save As dialog box.

2.	 Enter c19tut1 in the File name edit box and choose the Save button. The file gets saved at 
C:\CATIA\c19.

3.	 Close the part file by choosing File > Close from the menubar.

 Tutorial 2
In this tutorial, you will analyze the buckling case static analysis with enforce displacement on 
the variable radius shaft shown in Figure 19-126.  It is fixed at one end and the load is applied 
on the other end. The part file of this tutorial can be downloaded from www.cadcim.com. Under 
the given load and constraints, you will perform the static analysis on this shaft and then the 
buckling analysis with the help of the solution of the static analysis. The boundary conditions 
are given within the tutorial steps only.

(Expected time: 1.5hr)

Figure 19-126  Model of the variable radius shaft
The following steps are required to complete the tutorial.

a.	 Download and import the input file to the Generative Structural Analysis workbench.
b.	 Generate the mesh.
c.	 Apply constraints and loads.
d.	 Compute the static analysis.
e.	 Insert and compute buckling case.
f.	 Analyze the results.
g.	 Generate the buckling case analysis report.
h.	 Save the analysis.
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Downloading the Part File
Before starting the tutorial, you need to download the part file for this tutorial from the CADCIM 
website.

Download the file c19_catia_tut2.zip file from www.cadcim.com. The path of the file is as follows: 
Textbook > CAD/CAM > CATIA > CATIA V5-6R2017 for Designers > Input file.

Starting the Static Analysis
After extracting the input file, you need to open the variable radius shaft part file in CATIA. 

1.	 Start a new file in the Generative Structural Analysis workbench by choosing Start > 
Analysis & Simulation > Generative Structural Analysis. The New Analysis Case dialog 
box gets displayed along with the imported variable radius shaft part in the Generative 
Structural Analysis workbench.

2.	 Choose the Static Analysis option from the New Analysis Case dialog box and choose OK. 

The Generative Structural Analysis workbench will be displayed along with various analysis 
tools. Also, you will notice that a mesh icon at the center of the shaft.

Note
On invoking this workbench if a warning message box is displayed informing that the material is 
not properly defined on the part, choose OK from this warning message box to continue.

Applying the Material
Next, you need to apply the material to the shaft.

1.	 Click once on the shaft  from the graphics area and invoke the Library (Read only) dialog 
box by choosing the Material on Analysis Connection tool from the Material on Analysis 
Connection toolbar.

2.	 Make sure the Metal tab is selected in this dialog box.

3.	 Select the Iron metal to apply it on the imported shaft and choose the Apply Material 
button from this dialog box to apply the material to the shaft and choose OK. 

Generating the Mesh 
Next, you need generate the mesh on the shaft.

1.	 Invoke the OCTREE Tetrahedron Mesh dialog box by double clicking on the OCTREE 
Tetrahedron Mesh sub-node of the Nodes and Elements node.

2.	 Enter 10 mm in the Size edit box of the Global tab, 2 mm in the Absolute sag edit box, 
and keeping the other values as default, choose OK.



Introduction to FEA and Generative Structural Analysis	      19-61

Applying the Restraints and Loads to the Spring
Next, you need to apply the boundary constraints and loads on the shaft.

1.	 Choose the Clamp tool from the Restraints toolbar; the Clamp dialog box is displayed.

2.	 Choose the bottom face of the shaft, as shown in Figure 19-127 and then choose the OK 
button from the Clamp dialog box; the clamp restraint is applied, refer to Figure 19-128.

Figure 19-127  The bottom face to be selected Figure 19-128  The clamp restraint applied to 
the selected face

After applying the material and restraints to the shaft, you need to apply enforced displacement 
on the top face of the shaft. To apply the enforced displacement, first you need to create a user-
defined restraint. 

3.	 Choose the User-defined Restraint tool from the Advance Restraint sub-toolbar of the 
Restraints toolbar; the User-defined Restraint dialog box is displayed. 

4.	 Select the top face of the shaft, as shown in Figure 19-129. The selected face gets displayed 
in the Supports selection box. Next clear all  the restrain translation and rotation check 
boxes except the Restrain Translation 2 check box. Choose OK; the user defined restraint 
is applied, refer to Figure 19-130. 

Figure 19-129  The top face to be selected Figure 19-130  The User-defined Restraint 
restraint applied to the selected face

Next, you will apply the enforced displacement to the user-defined restraint applied on the shaft.

5.	 Choose the Enforced Displacement tool from the Loads toolbar; the Enforced Displacement 
dialog box is displayed.
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6.	 Choose the User-defined Restraint applied on the shaft from the graphics area; its name 
gets displayed in the Restraint selection box of the Enforced Displacement dialog box.

7.	 Enter -2 in the Translation 2 edit box and choose OK. 

Computing the Analysis
After applying all the restraints, loads, and mesh, you need to solve the static analysis for the shaft.

1.	 Choose the Compute tool from the Compute sub-toolbar; the Compute dialog box is 
displayed. Select the All option from the drop-down list available in this dialog box if not 
chosen by default and choose OK from this dialog box The Computing  process window 
and Computation Status message box are displayed. 

After the computing process is over, the Computation Resources Estimation message box is 
displayed.

2.	 Choose Yes from this message box. The Computing process window and the Computation 
Status display box are displayed again. 

Once the processing is over, the result is computed which you can view using the tools  in the 
Image toolbar. The Von Mises Stress generated is shown in Figure 19-131.

Figure 19-131  The Von Mises Stress generated  in the shaft

Inserting the Buckling Case
After analyzing the static case, you need to insert the buckling case to analyze the buckling in 
the Shaft. 

1.	 Choose the Insert > Buckling Case option from the menubar; the Buckling Case dialog 
box will be displayed. 

2.	 Select the static case analysis solution from the specification tree; its name will be displayed 
in the Reference selection box of the Buckling Case dialog box. Next choose OK. 
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You will notice that a new node as Buckling Case gets added to the specification tree, refer to 
Figure 19-132. 

Figure 19-132  The Buckling Case node added to specification tree

Computing the Buckling Case Analysis
Next, you need to compute the result for the buckling case analysis. 

1.	 Choose the Compute tool from the Compute sub-toolbar; the Compute dialog box is 
displayed. Again, choose the All option from the drop-down list available in this dialog box 
and choose OK from this dialog box. The Computing  process window and the Computation 
Status display box are displayed. 

After the computing process is over, the Computation Resources Estimation message box is 
displayed.

2.	 Choose Yes from this message box. The Computing process window and the Computation 
Status message box are displayed again. 

Once the processing is over, the result is computed which you can view using the tools  in the 
Image toolbar. 

Analyzing the Result for the Buckling Case Analysis
After the computation process is completed, you can analyze the result. 

1.	 Choose the Deformation tool from the Image toolbar; the deformation generated in the 
shaft is displayed in the graphics area, refer to Figure 19-133

Figure 19-133  The deformation in the shaft
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2.	 Double click on the Deformed mesh sub node, refer to Figure 19-134; the Image Edition 
dialog box gets displayed, as shown in Figure 19-13519-135. Choose the Occurrences tab 
if not chosen by default.

Figure 19-134  The Deformed mesh sub-node Figure 19-135  The Image Edition dialog box

3.	 Select the required modes from the available buckling factors under the Occurrences tab of 
this dialog box and choose OK. The selected deformed mode gets displayed in the graphics 
area. Figure 19-136 displays the deformed shaft.

Figure 19-136  The changed deformation in the shaft

Generating the Buckling Analysis Report
Next, you will generate the buckling analysis report of the result.

1.	 Choose the Generate Report tool from the Report sub-toolbar of the Analysis Report 
toolbar; the Report Generation dialog box is displayed. Specify the location to save the 
report. Choose the Buckling case from the Choose the Analysis Case(s) area and then 
choose OK. The analysis report is generated in .html format and is displayed in your default 
internet browser.

After completing the study procedure and generating the analysis report, you need to save the 
model.
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Saving and Closing the File
1.	 Choose the Save button from the Standard toolbar to invoke the Save As dialog box.

2.	 Enter c19tut2 in the File name edit box and choose the Save button. The file will be saved 
at C:\CATIA\c19.

3.	 Close the part file by choosing File > Close from the menubar.

Tutorial 3
In this tutorial, you will analyze frequency analysis results of a leaf spring. The part file of this 
tutorial can be downloaded from www.cadcim.com. The leaf spring is fixed at its both ends. Under 
the given load and restraints, you will perform the frequency analysis on this leaf spring. The 
boundary conditions are given within the tutorial steps only.

(Expected time: 1.5hr)

Figure 19-137  Model for leaf spring
The following steps are required to complete the tutorial.

a.	 Download and import the input file to Generative Structural Analysis workbench.
b.	 Generate the mesh.
c.	 Apply restraints.
d.	 Compute the frequency analysis.
e.	 Analyze the results.
f.	 Generate the analysis report.
g.	 Save the analysis.

Downloading the Part File
Before starting the tutorial, you need to download the part file for this tutorial from CADCIM 
website.

Download the file c19_catia_tut3.zip file from www.cadcim.com. The path of the file is as follows: 
Textbook > CAD/CAM > CATIA > CATIA V5-6R2017 for Designers > Input files.

Starting the Static Analysis
After extracting the input file, you need to open the leaf spring part file in CATIA. 

1.	 Start a new file in the Generative Structural Analysis workbench by choosing Start > 
Analysis & Simulation > Generative Structural Analysis. The New Analysis Case dialog 
box will be displayed along with the imported Leaf spring part in the Generative Structural 
Analysis workbench.
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2.	 Choose the Frequency Analysis option from the New Analysis Case dialog box and choose 
OK. 

The Generative Structural Analysis workbench will be displayed along with various analysis 
tools. Also, you will notice that a mesh icon will be displayed at the center of the leaf spring.

Note
On invoking this workbench, if a warning message box is displayed, informing that the material 
on the part is not displayed then choose OK to continue.

Applying the Material
Next, you need to apply the material to the leaf spring.

1.	 Click once on the leaf spring from the graphics area and invoke the Library (Read only) 
dialog box by choosing the Material on Analysis Connection tool from the Material on 
Analysis Connection toolbar.

2.	 Make sure the Metal tab is selected in this dialog box if not selected.

3.	 Select the Steel metal to apply it on the imported leaf spring and choose the Apply Material 
button from this dialog box to apply the material to the leaf spring and then choose OK. 

Generating the Mesh 
Next, you need to generate the mesh on the leaf spring.

1.	 Invoke the OCTREE Tetrahedron Mesh dialog box by double clicking on the OCTREE 
Tetrahedron Mesh sub-node of the Nodes and Elements node.

2.	 Enter 1 mm and 0.1 mm in the Size and Absolute sag edit boxes of the Global tab respectively, 
keeping the other values as default, choose OK.

Applying the Restraints to the Spring
Next, you need to apply the boundary constraints and loads on the leaf spring.

1.	 Choose the Clamp tool from the Restraints toolbar; the Clamp dialog box is displayed.

2.	 Choose the inner face of the curved face of the leaf spring, as shown in Figure 19-138 and 
then choose the OK button from the Clamp dialog box; the clamp restraint is applied, refer 
to Figure 19-139.
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Figure 19-138  The faces to be selected

Figure 19-139  The clamp restraint applied to the selected face

Computing the Analysis
After applying all restrains, and mesh, you need to solve the analysis for the model.

1.	 Choose the Compute tool from the Compute sub-toolbar; the Compute dialog box is 
displayed. Select the All option from the drop-down list available in this dialog box, if not 
chosen by default  and choose OK from this dialog box. The Computing process window 
and the Computation Status message box are displayed. 

After the computing process is over, the Computation Resources Estimation message box is 
displayed.

2.	 Choose Yes from this message box. The Computing  process window and the Computation 
Status display box are displayed again. 

Once the processing is over the result is computed, you can view the results using various tools 
available in the Image toolbar. 

Analyzing the Result
Now, after the computation process is completed, you can analyze the result. 

1.	 Choose the Von Mises Stress tool from the Image toolbar; the deformation generated in 
the leaf spring is displayed in the graphics area, refer to Figure 19-140.
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Figure 19-140  The Von Mises Stress generated  in the Leaf Spring

Now, you can view various occurrences of frequency.

2.	 Double click on the Von Mises stress sub node, refer to Figure 19-141; the Image Edition 
dialog box gets displayed. Choose the Occurrences tab from this dialog box, if not chosen 
by default. 

Figure 19-141  The Von Mises stress sub-node

3.	 Select the required mode from the available Frequency (Hz) list under the Occurrences 
tab at and choose OK. 

Generating the Analysis Report
Next, you will generate the analysis report of the result.

1.	 Choose the Generate Report tool from the Report sub-toolbar of the Analysis Report 
toolbar; the Report Generation dialog box is displayed. Specify the location to save the 
report and choose OK. The analysis report is generated in .html format and is displayed in 
your default internet browser.

After completing the study procedure and generating the analysis report, you need to save the 
model.
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Saving and Closing the File
1.	 Choose the Save button from the Standard toolbar to invoke the Save As dialog box.

2.	 Enter c19tut3 in the File name edit box and choose the Save button. The file is saved at C:\
CATIA\c19.

3.	 Close the part file by choosing File > Close from the menubar.

Tutorial 4
In this tutorial, you will analyze the effect of temperature on the Engine block shown in 
Figure 19-142. The part file of this tutorial can be downloaded from www.cadcim.com. Under the 
given load and constraints you will perform temperature analysis on this part. The boundary 
conditions are given within the tutorial steps only,

(Expected time: 1.5hr)

Figure 19-142  Model for Engine block

The following steps are required to complete this tutorial.

a.	 Download and import the input file to the Generative Structural Analysis workbench.
b.	 Generate the mesh.
c.	 Apply restraints.
d.	 Apply temperature field.
e.	 Compute the analysis.
f.	 Analyze the results.
g.	 Generate the analysis report.
h.	 Save the analysis.

Downloading the Part File
Before starting the tutorial, you need to download the part file for this tutorial from the CADCIM 
website.

Download the file c19_catia_tut4.zip file from www.cadcim.com. The path of the file is as follows: 
Textbook > CAD/CAM > CATIA > CATIA V5-6R2017 for Designers > Input files.
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Starting the Static Analysis
After extracting the input file, you need to open the Engine block part file in CATIA. 

1.	 Next, start a new file in the Generative Structural Analysis workbench by choosing Start > 
Analysis & Simulation > Generative Structural Analysis. The New Analysis Case dialog 
gets be displayed along with the imported Engine block part in this workbench.

2.	 Choose the Static Analysis option from the New Analysis Case dialog box and choose OK. 

The Generative Structural Analysis workbench will be displayed along with various analysis 
tools. Also, you will notice a mesh icon at the center of the Engine block part.

Applying the Material
Next, you need to apply the material to the Engine block.

1.	 Click once on the Engine block from the graphics area and invoke the Library (Read only) 
dialog box by choosing the Material on Analysis Connection tool from the Material on 
Analysis Connection toolbar.

2.	 Make sure the Metal tab is selected in this dialog box.

3.	 Select the Aluminium metal to apply it on the imported Engine block and choose the Ap-
ply Material button from this dialog box to apply the material to the Engine block. Next, 
choose OK. 

Generating the Mesh 
Next, you need to generate the mesh on the Engine block.

1.	 Invoke the OCTREE Tetrahedron Mesh dialog box by double clicking on the OCTREE 
Tetrahedron Mesh sub-node of the Nodes and Elements node. 

2.	 Enter 1 and  0.5 mm in the Size edit box and the Absolute sag edit box of the Global tab 
respectively, and keeping the other values as default choose OK.

Applying the Restraints to the Engine block
Next, you need to apply the boundary constraints and loads on the Engine block.

1.	 Choose the Surface Slider tool from the Mechanical Restraints sub-toolbar of the Restraints 
toolbar; the Surface Slider dialog box is displayed.

2.	 Choose all the 15 holes on the upper face of the Engine block, as shown in Figure 19-143. 
Apply the surface slider restraint to all the flat faces of the elongated holes. Choose the 
OK button from the Surface Slider dialog box; the surface slider restraint is applied to the 
selected holes, refer to Figure 19-144.
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Figure 19-143  The holes to be selected

Figure 19-144  The Surface Slider restraint applied to the selected holes

Applying Temperature Field to the part 
Next, you need to apply temperature filed on the Engine block.

1.	 Choose the Temperature Field tool from the Temperature sub-toolbar of the Loads toolbar; 
the Temperature Field dialog box is displayed.

2.	 Select the Engine block from the graphic area; its name gets displayed in the Supports 
selection box of this dialog box.

3.	 Specify the temperature value as 10 in the Temperature edit box and choose OK,

You will notice a T symbol will be displayed at the center of the Engine block.
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Computing the Analysis
After applying all the restraints, meshes, and temperature fields, you need to solve the analysis 
for the model.

1.	 Choose the Compute tool from the Compute toolbar; the Compute dialog box is displayed. 
Select the All option from the drop-down list available in this dialog box if not chosen by 
default and choose OK from this dialog box. The Computing process window and the 
Computation Status message box are displayed. 

After the computing process is over, the Computation Resources Estimation message box is 
displayed.

2.	 Choose Yes from this message box. The Computing  process window and the Computation 
Status display box are displayed again. 

Once the processing is over the result is computed, you can view the results using various tools 
available in the Image toolbar. Note that after the computation process if a message box displays 
that the rotation constraints were not taken into account as mesh part is 3D. Choose OK from 
this message box to continue and choose Yes from the Computation Resources Estimation 
message box.

Analyzing the Result
Now, after the computation process is completed, you can analyze the result. 

1.	 Choose the Von Mises Stress tool from the Image toolbar; the deformation generated in 
the Engine block is displayed in the graphics area, refer to Figure 19-145.

2.	 Choose the Principal Stress tool from the Image toolbar; the principal stress generated in 
the Engine block model is displayed in the graphics area, refer to Figure 19-146.

Figure 19-145  The Von Mises Stress generated  in the Engine Block



Introduction to FEA and Generative Structural Analysis	      19-73

Figure 19-146  The Principal Stress generated  in the Engine Block

Generating the Analysis Report
Next, you will generate the analysis report of the result.

1.	 Choose the Generate Report tool from the Analysis Report toolbar; the Report Generation 
dialog box is displayed. Specify the location to save the report and choose OK. The analysis 
report is generated in .html format and is displayed in your default internet browser.

After completing the study procedure and generating the analysis report, you need to save the 
model.

Saving and Closing the File
1.	 Choose the Save button from the Standard toolbar to invoke the Save As dialog box.

2.	 Enter c19tut4 in the File name edit box and choose the Save button. The gets saved at C:\
CATIA\c19.

3.	 Close the part file by choosing File > Close from the menubar.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 The ____________ tool is used to generate and save the animation view of the results 
generated in the postprocessing phase.

2.	 The maximum stress that can be applied to a material without producing permanent 
deformation is known as the ___________ of the material.

3.	 The _________ tool adds a spherical joint restraint to the points of virtual parts, it constraint 
a part to rotate around a fixed point.
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4.	 You can restraint the required degree of freedom by checking and clearing the required  
_____________ and ____________ check boxes from the User-defined Restraint dialog box.

5.	 The________________ tool creates a triangular or quadrangular mesh elements on the 
selected surface.

6.	 The Beam Mesher tool is used to mesh the _______ parts which are also known as line 
bodies.

7.	 The 3D Property tool allows you to add 3D physical properties to a shape design by selecting 
a meshed wireframe geometry. (T/F)

8.	 The User-defined restraints are generic restraints which restrict fixing any combination of 
nodal degree of freedom available for any arbitrary geometry. (T/F) 

9.	 The Ball Joint tool adds a spherical join restraint to the points of virtual parts. (T/F)

10.	 The Translation Mesher tool is used to create a rotation mesh part from an already defined 
mesh part. (T/F)

 Review Questions 
Answer the following questions: 

1.	 Which of the following tools is only available with the CATIA V5 Advanced Meshing Tools 
workbench.

		  (a) Extrude				    (b) Edge Fillet
		  (c) Revolve				    (d) Sweep 3D

2.	 The ___________are generic restraints allow you to fix any type of combination of nodal 
degree of freedom which is available for any arbitrary geometry. 

3.	 The __________ tool allows you to add 3D physical properties to a shape design by selecting 
a meshed wireframe geometry.

4.	 The ___________ tool is used to split quadrangle mesh elements into triangle mesh elements.

5.	 The__________ tool allows you to add 2D physical properties to a shape design by selecting 
a meshed wireframe geometry.

6.	 The ____________tool is used to apply temperature constant to a part.

7.	 The Temperature Field tool is available in the _________ toolbar.

8.	 Generative Structural analysis examines the response of a structure or component to design 
strategies.  (T/F)
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9.	 A rigid spring virtual part is an elastic body which connects a specific point to a specific 
geometry. (T/F)

10.	 The Ball Joint tool adds a spherical join restraint to the points of virtual parts  (T/F)

Exercises
 Exercise 1

Download the file c19_catia_exr01.zip file from www.cadcim.com. The path of the file is as follows: 
Textbook > CAD/CAM > CATIA > CATIA V5-6R2017 for Designers > Input file and then extract it 
to save the file. Next, you will perform the static analysis of the model. The holes of the model 
that are fixed are shown in Figure 19-147. A load of 100 N is applied to the upper holes, refer 
to Figure 19-147.  The model is made up of steel.	
						             (Expected time: 45 min)         

Figure 19-147  The model for Exercise 1
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Answers to Self-Evaluation Test
1. Animate, 2. elastic limit, 3. Ball Joint, 4. Restrain Translation, Restrain Rotation,  
5. Surface Mesher, 6. 1D, 7. T, 8. F, 9. T, 10. T


